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1 Welcome
About This Manual
What’s New in the Quantum GX2 microCT Imaging System  on page 2
Quantum GX2 microCT Help  on page 3
Additional Important Documentation  on page 3
Contact Information  on page 4

1.1 About This Manual
Welcome to the Quantum GX2 microCT Imaging System Manual. The Quantum GX2 microCT 
Imaging System is a high-speed CT system used for small animal X-ray imaging. 

The imaging system is a low-dose X-ray micro-computed tomography scanner. The scanner acquires 
high-quality slice images which are rendered for 3D visualization. The system is appropriate for 
preclinical longitudinal studies of small animals.

The imaging system uses a cone beam X-ray source and a flat panel X-ray detector to produce high 
resolution 3D images of small animal bone structure and surrounding soft tissue. 

Figure 1.1  Quantum GX2 microCT Imaging System
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The Quantum GX2 microCT Imaging System is an integrated imaging system that includes:

 A module for X-ray imaging.

 A Windows®-based computer workstation for data acquisition and analysis.

 Software:

This manual explains how to:

 Operate and maintain the Quantum GX2 microCT Imaging System

 Obtain and view CT images

Please read this manual carefully before using the Quantum GX2 microCT Imaging System to obtain 
safe, optimum performance, and a maximum service life from the imaging system.

1.2 What’s New in the Quantum GX2 microCT Imaging System
Table 1.1 lists the new or improved features for the Quantum GX2 microCT Imaging System.

Name Description 

Quantum GX2 4.0 Software For image acquisition, data analysis, reconstruction, and post-
processing. Factory-installed on the imaging system 
workstation.

Quantum GX2 Image Analysis Software Enables post-acquisition analysis of raw image data, 
reconstruction, and display of CT images. For use on an analysis 
only workstation which is not connected to the imaging system. 

Quantum GX2 Viewer Pack Software CT image display only. For use on a laptop or desktop computer. 

Table 1.1  Quantum GX2 microCT Imaging System New or Improved Features

Item Description See Page

Computer and software  Larger local storage with 2 TB hard drive.
 Improved graphics card – NVIDIA GeForce GTX 1080.
 Support for Windows 10.

Data management  Move image data to a different sample and study.
 Delete image data (requires Administrator privileges).

34

34

Gating  More robust cardiac gating
 Respiratory rate displayed (breaths per minute) during gated scan setup. 53

18mm FOV Smaller FOV for high resolution imaging of ex vivo samples.

86mm FOV Wider FOV for additional application support. Entire rat lungs can be 
imaged using this FOV in a one second scan.

Changeable X-ray filters Choose between 6 filters to optimize imaging protocols. 64

High speed scan High speed scan times as fast as 3.9 seconds.
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1.3 Quantum GX2 microCT Help
You can view a tooltip about a software button function by putting the mouse cursor over the button.

1.4 Additional Important Documentation
Table 1.2 lists other important documentation related to the use of the Quantum GX2 microCT 
Imaging System. 

Work with data offline Quantum GX Image Analysis Software for working with image data offline 
on a workstation not connected to the imaging system.
 View 2D image data and 3D reconstructions.
 Post-acquisition processing of gated image data
 Post-acquisition reconstruction of slices or subvolume at higher 

resolution.

37

Estimated radiation dosage Control panel displays the estimated radiation dosage (mGy) based on the 
acquisition settings.

27

Reconstruction improvements  Subvolume and slice reconstructions for subjects that contain metal.
 Improved accuracy of grayscale values.

Viewer  View Z-axis maximum intensity projection (MIP) in the 2D viewer.
 Additional 3D filters (EDGE and BONE) for enhanced visualization.

71

3D Viewer  "Artistic mode" display generates 3D renderings of the image using factory 
installed colormaps.

72

Table 1.2  Documentation for the Quantum GX2 microCT Imaging System

Document Name Description Part No.

Safe Operating and Emergency 
Procedures for the Operation of the 
Quantum GX2 microCT Cabinet X-Ray 
System

Provides detailed instructions on the safety 
features, operating procedures, and emergency 
procedures for the Quantum GX2 microCT 
Imaging System.

CLS150200

Mouse Imaging Shuttle Instructions Explains how to install and use the optional Mouse 
Imaging Shuttle that can be used to contain the 
subject during optical and CT imaging. The Mouse 
Imaging Shuttle enables imaging and transfer of 
subjects between imaging platforms without 
disrupting the subject position. As a result, 3D 
optical and 3D volumetric data can be precisely 
registered.

127820

Table 1.1  Quantum GX2 microCT Imaging System New or Improved Features (continued)

Item Description See Page
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1.5 Contact Information
PerkinElmer Health Sciences
940 Winter Street
Waltham, Massachusetts 02451 USA
www.PerkinElmer.com

Technical Support 
Telephone: +1 (800) 762-4000 (US) or +1 (203) 425-4602
Fax: +1 (203) 944-4904
E-mail: global.techsupport@perkinelmer.com

Sales: CustomerCareUS@perkinelmer.com

www.PerkinElmer.com
mailto:global.techsupport@perkinelmer.com
mailto:CustomerCareUS@perkinelmer.com


2 Safety, Warnings, and Radiation Hazards
Important Safety Information
Warnings  on page 10
X-Ray Safety and Radiation Hazards  on page 12

2.1 Important Safety Information
This manual provides safety information in the following formats:

Safety Symbols

Table 2.1 shows safety symbols that are found on the Quantum GX2 microCT and in this manual. 

! CAUTION: A caution note indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury and/or mechanical damage. It is also
used to alert you to unsafe practices. It reminds you that all safety instructions should
be read and understood before installation, operation, maintenance, or repair of this
imaging system. When you see this symbol, pay particular attention to the safety
information presented. Observance of safety precautions will help avoid actions that
could damage or adversely affect the performance of the Quantum GX2 microCT
Imaging System. If the equipment is used in a manner not specified in this manual, the
protection provided by the equipment may be impaired.

! WARNING! Used when an action or condition may potentially cause serious personal
injury or loss of life. Mechanical damage may also result.

VOLTAGE! Provides safety information about high voltage or risk of electric shock.

Table 2.1  Safety Symbols

Symbol Definition

Warning: Hazardous voltage.

Warning: The equipment produces X-rays when energized.

Warning (Canada): The equipment produces X-rays when energized.
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Instructions

Read Instructions

Read and understand all the safety and operating instructions before you install, operate, or perform 
maintenance on the Quantum GX2 microCT. Make sure that you fully understand the following 
safety instructions, warnings, and disclaimers before proceeding to the rest of the manual.

Retain Instructions

Retain the safety and operating instructions for future reference.

Follow Instructions

Follow all operating and handling instructions. Failure to follow operating or handling instructions 
may void any warranty covering this product.

Heed Warnings

Abide by all warnings on the product and in the operating instructions. Failure to adhere to warnings 
or safety precautions may void any warranty covering the Quantum GX2 microCT.

X-Ray Safety & Hazards: Regulations

This equipment produces X-rays when energized. Before operating the equipment, read and 
understand the specific information in X-Ray Safety and Radiation Hazards on page 12. DO NOT 
operate the Quantum GX2 microCT unless an X-ray safety survey has been performed within the last 
12 months. For more information, please contact PerkinElmer technical support.

An X-ray safety survey must be performed when the imaging system is installed or after it has been 
moved. A survey is also to be performed when the Quantum GX2 microCT has undergone any form 
of service in which the access panels have been opened, the safety interlocks have been adjusted, or 
any of the shielding has been removed and re-installed.  

After servicing, if the safety interlocks are not operating properly or if the X-ray shielding is not 
properly re-installed, serious injury can result when operating the system. Conducting an X-ray 
safety survey is the only way to confirm proper shielding and interlock operation. 

Owners and operators of the Quantum GX2 microCT are responsible for complying with all 
regulations in the country where the equipment is operated. This includes all local, state, and federal 
regulations. In some states of the US, it may be necessary to register radiation sources with the 
governing state and/or local public health agencies before operating the imaging system. Equipment 
registration may be required immediately or within 30 days of acquiring the equipment.

Owners and operators of the Quantum GX2 microCT are responsible for contacting the appropriate 
public health agencies for registration information that pertains to installation of the Quantum GX2 

! WARNING! The Quantum GX2 microCT should be operated only by personnel who
have been trained in radiation safety and the operation and safety instructions
contained in this manual. PerkinElmer also recommends that personnel who operate
the equipment, or are close proximity to the equipment, use a radiation film badge or
other type of appropriate personal dosimeter

! WARNING! For radiation survey of the Quantum GX2 microCT, please comply with
your own laboratory radiation regulations or contact PerkinElmer technical support for
further assistance.
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microCT. If you need assistance with this requirement, contact PerkinElmer technical support. For 
more details and contact information, see Safe Operating and Emergency Procedures for the 
Operation of the Quantum GX2 microCT Cabinet X-Ray System. This document was provided with 
the pre-installation instructions.

Environmental Considerations for the System Components

Locating the Quantum GX2 microCT

Consider the proper environment for the components before installation of the Quantum GX2 
microCT.

Install the equipment in an environment where:

 The temperature does not fluctuate widely and is maintained between 15-25° C (59-77° F).

 The humidity does not exceed 80%.

 No strong electric or magnetic fields exist.

 No vibrations are present.

 No corrosive gases are present.

 High amounts of dust are not present (Pollution Degree 2).

 No open flame is present.

 There is sufficient space behind the Quantum GX2 microCT equipment. A minimum space of 
4 inches (10 cm) from the flat surface of the rear panel should be provided behind the Quantum 
GX2 microCT to provide unobstructed air flow and access to the main power on/off switch.

 The work space is level.

 Altitude is ≤ 2000 meters.

Heat

The system should be situated away from heat sources such as open flames, radiators, heat registers, 
stoves, and other heat-generating electrical equipment.

Water and Moisture

! WARNING!  A PerkinElmer employee will conduct a radiation leakage survey and
safety tests when the Quantum GX2 microCT is installed. PerkinElmer employees are
trained in radiation safety. However, check with your local radiation control authority
to determine the specific radiation survey requirements at your facility. If necessary,
have a qualified expert other than a PerkinElmer employee survey the installation
before operating the imaging system.

! WARNING! Confirm that X-ray generation is stopped or active in at least two ways.
These may include X-ray generation display on the control screen, tube voltage
display, and tub current display, as well as the X-ray generation pilot lamp.Ensure that
the alarm equipment is used to inform the surroundings when X-rays are being
generated.

VOLTAGE! Do not use this product near water (for example, near a sink or wet room)
due to risk of electric shock, electrical damage, and/or equipment failure. 
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Cleaning or Moving the System Components

Cleaning/Liquid Entry

Clean the exterior of the scanner by wiping with a damp, soft cloth.

Moving the Quantum Quantum GX2 microCT

Power Considerations

Power Sources

The Quantum GX2 microCT is configured for the voltage requirements of the installation locality 
that was specified at the time of order. If the Quantum GX2 microCT is moved to another area, make 
sure that the same voltage requirements exist.

Intended to be powered by a standard wall receptacle (Overvoltage Category II).

Power Cord Protection

Power supply cords should be routed so that they are unlikely to be walked on or pinched by items 
placed upon or against them. Pay close attention to receptacles and to points of connection between 
cords and equipment.

Do not replace the power cord provided with inadequately rated nor uncertified replacement. The 
power cord's plug at the wall or the AC inlet at the rear of the system should remain accessible after 
installation, to allow disconnection of power should it be needed for safe servicing.

VOLTAGE! Do not use liquid or aerosol cleaners and never spill liquid of any kind on
any of the Quantum GX2 microCT components. Sprays and liquids that come into
contact with the Quantum GX2 microCT hardware may result in damage to the system
or electrocution. For more details on proper care of the system, see Cleaning the
Quantum GX2 microCT on page 81

! WARNING! Only PerkinElmer employees are authorized to move the Quantum GX2
microCT Imaging System.

Table 2.2  Voltage Ratings (Nominal and Max)

120Vac, 8A, 50/60HZ (108-132Vac)

208Vac, 4A, 50/60HZ (187-229Vac)

220Vac, 4A, 50/60HZ (198-242Vac)

230Vac, 4A, 50/60HZ (207-253Vac)

240Vac, 4A, 50/60HZ (216-264Vac)

! WARNING! The Quantum GX2 microCT can operate at multiple voltages, such as
120V, 230V, or 240V, with the factory setting marked on the imaging system label.
However, you are not permitted to change the input voltage to any of the system
components. Several internal modifications are required for voltage change. If the
operating voltage must be changed, contact PerkinElmer technical support.
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Lightning & Power Line Surges

The Quantum GX2 microCT is supplied with a surge protector. All components should be connected 
to this device to protect against electrical transient events.

Power Outages

If the Quantum GX2 microCT experiences a loss of supply power, turn off the power switch for all 
components and do not restart the system until reliable power has been restored.

Overloading

Facilities should be adequately wired according to local building codes.

Servicing

Refer all servicing to PerkinElmer technical support. If the Quantum GX2 microCT is damaged and 
requires service, unplug the Quantum Quantum GX2 microCT from the outlet and contact 
PerkinElmer technical support. Servicing by anyone other than an authorized PerkinElmer 
representative voids the warranty covering the Quantum GX2 microCT.

Other Equipment

Use of any equipment other than that recommended by this manual has not been evaluated for safety 
and, therefore, is the sole responsibility of the user.

Do not modify the Quantum GX2 microCT in ANY manner by making any kind of hole or aperture 
in the imaging system or removing any component of the radiation shielding.

! WARNING! Do not overload wall outlets, extension cords, or integral convenience
receptacles as this can result in a risk of fire or electric shock. See Power Sources on
page 8 for more details on the power requirements of the Quantum GX2 microCT
Imaging System. 

! WARNING! The Quantum GX2 microCT Imaging System requires special precautions
regarding EMC and must be installed and put into service according to the EMC
information provided in the service manual.

! WARNING! Portable and mobile RF communications equipment can affect the
Quantum GX2 microCT Imaging System.

! WARNING! The Quantum GX2 microCT Imaging System complies with CISPR 11 group
1 Class A and may cause radio interference or may disrupt the operation of nearby
equipment. It may be necessary to take mitigation measures, such as reorienting or
relocating the equipment, or shielding the location.
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2.2 Warnings

Electrical Safety

X-Ray Safety

Mechanical Safety

The Quantum GX2 microCT Imaging System is heavy and weighs approximately 600 kg. The 
imaging system has many internal motorized components that can move at any time. 

The X-ray flat panel detector and source located inside of the bore area are delicate parts and should 
not be handled with bare hands or sprayed with cleaning agents.

VOLTAGE! DO NOT attempt to service the Quantum GX2 microCT Imaging System
yourself. Although there are no voltages in excess of 24V inside the sample bore area,
high voltages are present behind interlocked access panels. Contact PerkinElmer
technical support for electrical service needs.

! CAUTION: Depending on environmental or use conditions, such as humidity, using
the equipment without grounding may lead to electric shock. To ensure safety,
securely connect the ground wire of the power cable or the ground terminal of the
equipment (Class D grounding) to ground.

WARNING! The equipment produces X-rays when energized.

WARNING! The Quantum GX2 microCT Imaging System should be operated
only by personnel who have been trained in radiation safety and the operation
and safety instructions contained in this manual. PerkinElmer also
recommends that personnel who operate the equipment, or are close proximity
to the equipment, use a radiation film badge or other type of appropriate
personal dosimeter.

! WARNING! If the gas hoses become caught, kinked, or disconnected, do not operate
the imaging system. Over exposure to anesthesia gas may occur.

! CAUTION: The bore cover and the sample bed are made of an acrylic material. To
avoid damage, do not wash with organic solvents.

! CAUTION: Confirm that the sample and the sample bed are not in the sample chamber
during the system warm-up. If so, the detector may be damaged by overexposure,
resulting in degradation of the CT image.
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Chemical & Biological Safety

Normal operation may involve the use of test samples that are pathogenic, toxic, or radioactive. It is 
your responsibility to ensure that all necessary safety precautions are taken before such materials are 
used. 

Dispose of all waste materials according to appropriate environmental health and safety guidelines. 

It is your responsibility to decontaminate the Quantum GX2 microCT Imaging System before 
requesting service by PerkinElmer technical support. Ask your laboratory safety officer to advise you 
about the level of containment required for your application and about the proper decontamination 
or sterilization procedures to follow. 

Handle all infectious samples according to good laboratory procedures and methods to prevent the 
spread of disease. 

WARNING! Do not attempt to remove or modify the access tube in the sample
chamber. Doing so may lead to hazardous X-ray exposure.

! CAUTION: Bind the tubes and cables injected into the sample chamber firmly as the
damage to the tubes or cables may be caused by contact with the gantry arm.

! CAUTION: The image may be degraded if the contrast medium adheres to the bore
cover or sample bed. Wipe off any adherent contrast medium before it hardens and
dries.

! CAUTION: If gas anesthesia is to be used, the RAS-4 Anesthesia System and the
Mouse Imaging Shuttle are recommended. Ensure adequate ventilation before using
gas anesthesia equipment. See the Mouse Imaging Shuttle Instructions (part no.
127820_RevA) on the use of the transfer bed and Mouse Imaging Shuttle.

! CAUTION: Use the attachment screws to attach the bore cover to the face plate.
Loose attachment screws or incomplete attachment of the bore cover may result in
damage to the bore cover during imaging.

! CAUTION: To avoid system malfunction, do not shut down the computer during
control software startup or quit the control software during CT imaging or live scan
modes.

! CAUTION: Do not use this Quantum GX2 microCT Imaging System for medical
purposes such as diagnosis or treatment.
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Access Panels

There are no user serviceable components in the lower electronics area, or in the side and rear panels 
of the Quantum GX2 microCT Imaging System. Do not remove the electronics tray from the imaging 
system or the cover from the light source module unless you are instructed by and under the 
supervision of a PerkinElmer technical service representative. 

Do not modify the Quantum GX2 microCT Imaging System in ANY manner by making any kind of 
hole or aperture in the imaging system or removing any component that is part of the radiation 
shielding.

2.3 X-Ray Safety and Radiation Hazards
The Quantum GX2 microCT Imaging System produces X-rays when the X-ray function has been 
energized and initiated. The Quantum GX2 microCT Imaging System is defined by most regulatory 
agencies as a "Cabinet X-Ray System." A cabinet system is one that produces little or no X-ray 
exposure to the user and is safe to operate with the user in close proximity. PerkinElmer certifies the 
Quantum GX2 microCT Imaging System to produce not more than 0.5 millirem per hour at a distance 
of 5 cm from the instrument surface. In addition, the instrument is certified to meet all international 
exposure requirements (typically, 0.1 millirem per hour) and other regulations for where it is sold. 
The Quantum GX2 microCT Imaging System meets all US (FDA) regulations regarding a cabinet X-
ray system.

Effects of Radiation

The Quantum GX2 microCT Imaging System produces ionizing radiation in the energy range from 
0 to 90 kilovolts (X-ray). While this energy can be hazardous to the human body, the shielded cabinet 
protects the user or others in the vicinity from any exposure above background. The user is 
responsible for minimizing the total X-ray exposure to the individual mouse or other animal subject 
as part of the total amount of time spent imaging. 

Only individuals who have been trained to operate the equipment should be permitted to use it. In 
some locations, government regulations may require that the user have radiation training and be 
certified.

! WARNING! This equipment uses a beryllium window X-ray tube. Beryllium is
hazardous to the human body. Contact a professional waste disposal service to
dispose of X-ray tubes. Do not mix with general consumer waste.

! WARNING! The X-ray emission window of the X-ray tube contains metallic beryllium.
Avoid any contact with the window with bare hands. Beryllium powder or vapor is
hazardous to the human body. Avoid grinding, processing, or burning the beryllium
window. Avoid wiping the window with chemicals. In case of accidental contact
between your skin and the window, immediately wash the affected area with soap
and water. Comply with all applicable regional rules concerning proper disposal when
disposing of the X-ray tube (the unit containing the X-ray tube).

WARNING! This product produces X-rays. Do not attempt to open the
Quantum GX2 microCT door when X-rays are being generated as
indicated by the "X-Ray On" light on the front panel and on the
computer monitor.
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X-Ray Dose Limits

A sample model of PerkinElmer Quantum GX2 microCT Imaging System has been tested at 
maximum operating conditions. PerkinElmer has determined the local X-ray dose rate at a distance 
of 5 cm from the surface of the equipment is less than 0.5 mrem/h.

PerkinElmer declares that the Product Quantum GX2 microCT Imaging System conforms to:

 1996/29/Euratom Directive (Dose rate of 0.5 mrem/h at 10 cm from any accessible surface under 
normal operating conditions)

 US CFR21 Part 1020.40 Regulation (Dose rate of 0.5 mrem/h at 5 cm outside of the external 
surface under maximum operating conditions) in accordance with the following standard:

IEC 61010-1:2001 Standard (Dose limit of 0.5 mrem/h at 5 cm from the surface of the equipment 
under maximum operating conditions)

PerkinElmer certifies that Quantum GX2 microCT Imaging System has achieved the objectives of:

 ICRP 60 recommendations of annual public dose limit of 100 mrem 

 ICRP 103 recommendations of annual public dose limit of 100 mrem

 US OSHA workplace annual public dose limits of 100 mrem and other international public safety 
standards and regulations

Safety Features & Safety Systems

The Quantum GX2 microCT is enclosed within shielding that limits X-ray exposure to normal 
background levels. The access door to the sample chamber is provided with two safety interlocks 
which cut power to the X-ray source if they are interrupted. Additionally, the door is provided with 
a solenoid-activated lock that prevents the door from being opened during an imaging session when 
X-rays could be generated. For reasons discussed in the warning above, it is important not to attempt 
defeat of any of these safety features.

PerkinElmer will perform at least two safety tests on every system at the time of installation:

 At the time of manufacturing

 At the user's laboratory or facility

The safety test includes, but is not limited to, an X-ray radiation leakage test.

! WARNING! Do not modify this product in ANY way. Do not drill or modify the
shielding panels in ANY way. Do not operate the instrument or turn on the source
unless all shielding is in place and is in good repair. Do not attempt to access the
electronics compartment below the imaging chamber. Operation of the instrument in
a modified condition could result in exposure to X-rays. Exposure to X-rays can cause
serious bodily injury or death. Refer all servicing to PerkinElmer technical support.

! WARNING! Do not, for any reason, attempt to defeat the built-in safety interlocks
described in Safety Features & Safety Systems on page 13. Operating the Quantum
GX2 microCT Imaging System without the safety interlocks can result in exposure to
X-rays. Exposure to X-rays can cause serious bodily injury or death. Refer all servicing
to PerkinElmer technical support.
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PerkinElmer recommends, and some local government agencies may require, an X-ray leakage safety 
test be performed under the following conditions:

 Every 12 months

 After a PerkinElmer technician performs maintenance or service, in which case the safety survey 
will be conducted by PerkinElmer

 After any abnormal condition that could impair any of the safety systems. For example, the door 
becomes difficult to open or close. 

See Surveying the Quantum GX2 microCT for Radiation Leakage on page 80 for more information.

Regulatory Compliance

Customers in the US are directed to check with their state radiation control program director for 
registration requirements. For a list of U.S. state agencies and Canadian Provinces, see the Safe 
Operating and Emergency Procedures for the Operation of the Quantum GX2 microCT Cabinet X-
Ray System document. This document was provided as part of the pre-installation instructions and is 
also included on the same CD-ROM as this manual. International customers should check with their 
governing bodies about possible registration or other requirements.

PerkinElmer certifies that the Quantum GX2 microCT Imaging System complies with FDA 
regulation CFR 1020.40 after installation at the customer's site. PerkinElmer also certifies that the 
instrument meets all of the International regulations of the country where it is installed.

! WARNING! A PerkinElmer employee will conduct a radiation leakage survey and
safety tests after the Quantum GX2 microCT Imaging System is serviced by
PerkinElmer. PerkinElmer employees are trained in radiation safety. However, check
with your local radiation control authority to determine the specific radiation survey
requirements at your facility. It necessary, have a qualified expert other than a
PerkinElmer employee survey the installation before operating the instrument.



3 Quantum GX2 microCT Imaging System Components
Components
Door Operation on page 20
X-Ray System Control Panel on page 20
Key Selector Switch Lost Keys on page 21
Scanning System and Acquisition Computer Specifications on page 21
Environmental Requirements on page 22
Tube Inlet on page 22
Transfer Bed and Mouse Imaging Shuttle on page 23
FMT Mouse Imaging Cassette on page 24

3.1 Components
The Quantum GX2 microCT Imaging System includes scanner with a movable sample holder 
surrounded by a rotating gantry (Figure 3.1). The gantry has an X-ray source and a flat panel detector 
mounted on it. The detector and slide can be moved radially to change the magnification. Multiple 
bore sizes are available, depending on the magnification chosen.

Figure 3.1  Quantum GX2 microCT Imaging System

PC monitor

CT device

PC cabinet
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Figure 3.2  Quantum GX2 microCT Scanner – Front

Figure 3.3  Quantum GX2 microCT Scanner – Rear

System front panel
See Figure 3.4 for 
more details.

X-ray ON 
indicator

Tube inlet

Safety key switch

PC cabinet

Main electrical power 
ON/OFF switch

Power cord
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Figure 3.4  Quantum GX2 microCT Imaging System Front Panel

Figure 3.5  Quantum GX2 microCT Imaging System Sample Chamber

Emergency OFF button Power ON/OFF button

Y-axis stage controls

X-axis stage controls Z-axis stage controls

Bore cover

Sample bed

Sample table
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Table 3.1  Standard Accessories

Item Photo

Mouse bed

Rat bed

Small bore cover

Large bore cover

18mm FOV bore cover and bed No photo available.

86mm FOV bore cover and bed No photo available.

Changeable X-ray filters No photo available.
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Control Panel

The Control Panel appears when the Quantum GX2 microCT software starts (Figure 3.6). See:

 Page 26 for instructions on starting the software and Control Panel details.

 Page Table 4.2 on page 27 for details on the Control Panel.

Figure 3.6  Control Panel

Table 3.2  Scan Acquisition and Display Parameters

Parameter Description

Voltage Variable voltage up to 90 kV.

CT Variable current up to 200 µA.

Live Variable current up to 500 µA.

FOV (mm) Acquisition – Field of view for acquisition, variable 18 - 86 mm.

Reconstruction – Field of view for reconstruction, variable.

Voxel Size Voxel size determined by the software based on the acquisition FOV and 
reconstruction FOV.

Scan Mode  Standard – A common scan configuration for low dose in vivo imaging. 
 High Resolution – A scan mode that reduces image noise. 
 High Speed, Whole Body – A scan configuration that performs multiple scans and 

stitches them together to increase the axial field of view. After the first scan, the bed 
moves into the bore and the next scan is completed. The software uses the images 
from all of the scans to generate the 3D reconstruction (.vox).

 High Speed – A scan mode that is as fast as possible to reduce dose.
 High Speed, Gating – A scan configuration which mitigates motion artifacts from 

cardiac and respiratory rhythms. Note: Gating is optional.

Note: See Table 6.2 on page 44 for details on Preset Scan Configurations.

Display Settings 3D filters remove noise by combining pixels and displaying the average intensity of 
the selected pixels:

Original – Does not apply a filter.

Soft – Applies a 3 x 3 x 3 averaging filter.

Smooth – Applies a 5 x 5 x 5 averaging filter.
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3.2 Door Operation
The Quantum GX2 microCT sample chamber door has shielding to prevent the escape of X-ray 
radiation and should not be tampered with or modified in any way. The door also contains part of the 
X-ray safety interlock system. When the door is open, the X-ray source cannot be powered on. Never 
try to defeat the safety interlock function by defeating its purpose or modifying the mating safety 
interlock. This safety interlock should be visually inspected daily for signs of malfunction.

3.3 X-Ray System Control Panel
The main ON/OFF switch that controls the electrical power to the full imaging system is on the rear 
of the Quantum GX2 microCT (see Figure 3.3 on page 16). Activation of this switch provides power 
to the imaging system, but does not permit energizing the X-ray source unless the following 
conditions have been met:

 The sample chamber door is completely closed and the door handle is in the completely closed 
position.

 The Emergency OFF switch is in the ON (out) position (Figure 3.7).

 The key selector switch is turned ON.

 All access panels are secured.

The X-ray source cannot be energized from the Quantum GX2 microCT Imaging System control 
software until these conditions have been fulfilled.

Table 3.3  X-ray Source Specifications

Item Description

High Voltage Potential 90 kV

Maximum Current 200 µA

Maximum Power 8 W

Anode Type Tungsten

Window Beryllium

Focal Size 5 – 30 µm

Filter Changeable (see Imaging With Different X-
Ray Filters, page 64).

NOTE: The Emergency OFF button is not intended as a main X-ray source control and should
not be used to turn the X-ray function ON or OFF on a routine basis. It should only be used in
the unlikely situation where the X-ray source must be immediately turned OFF. It should be left
in the ON position under normal circumstances.

Figure 3.7  Front Panel – Emergency Stop Button 

Emergency OFF button
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3.4 Key Selector Switch Lost Keys
X-ray safety regulations require controlled access to the Quantum GX2 microCT Imaging System. 
The objective of this requirement is to prevent untrained and unauthorized personnel from operating 
the X-ray functionality of the imaging system. The key-operated switch on the imaging system 
fulfills this requirement when used in conjunction with the user's own written radiation safety 
procedures. The control of the key is typically managed by a master key person. 

The key-operated switch is designed so that the key cannot be removed except in the OFF position. 
When the authorized user is finished using the imaging system, the key is removed from the switch. 
Two keys are provided with the imaging system, and it is a good practice to archive the spare key. If 
the keys are lost, contact PerkinElmer technical support (see page 4).

3.5 Scanning System and Acquisition Computer Specifications 
The computer contains an Intel family processor and Windows® operating system. The computer 
controls the Quantum GX2 microCT Imaging System. A printer can be connected to the computer. 

Scanning System Specifications

Computer Features

 High speed Windows®-based PC

 Microsoft Windows 10 64-bit operating system

 16GB RAM

 2TB hard drive

 Quantum GX2 microCT Imaging System control software

 CD-burner installed for data storage and transport

 Network ready

 21.5" flat screen monitor

 Microsoft Office installed

Scanner Item Description

Power Requirements 100/120V, 8A, 50/60 Hz

240V, 4A, 50/60 Hz

Dimensions 138 cm W, 106 cm D, 130 cm H

Door opening dimensions 250 mm x 257 mm

Weight 489 Kg
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Computer Specifications

Computer Monitor Specifications

3.6 Environmental Requirements

3.7 Tube Inlet
The Quantum GX2 microCT Imaging System is equipped with a tube inlet for use with external 
devices such as the RAS-4 Anesthesia System or angiographic injectors that are inserted into the 
sample chamber or gantry (Figure 3.8). Anesthesia tubing and manifolds for the small and medium 
animal beds are provided with the standard accessories kit.

Item Description

Power requirements 1.0 A at 120 V, 0.5 A at 240 V, 50-60 Hz

Dimensions (H x W x D) 17.5 x 6.75 x 18.3 in 

(44.45 x 17.15 x 46.48 cm)

Graphics card NVIDIA GeForce GTX 1080

Computer Monitor (Flat screen) Description

Power requirements 0.6 A at 120 V 0.35 A at 240 V 50-60 Hz

Dimensions with stand 17.5” x 17.5” x 9” 45 cm x 45 cm x 23 cm

Weight with stand 33 lbs 15 Kg

Dimensions without stand 17.5” x 17.5” x 2.5” 45 cm x 37 cm x 6.5 cm

Weight without stand 20 lbs 9 Kg

Environmental Requirements Specification

Temperature 15° C to 25° C (50° F to 78° F)

Humidity 0% to 80% non-condensing

Type of use Indoor

Imaging chamber shelf temperature Ambient to 37° C

Altitude rating <2000 meters (6560 ft.)

Pollution degree 2

Installation category II
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3.8 Transfer Bed and Mouse Imaging Shuttle
The transfer bed is for use with the optional Mouse Imaging Shuttle (Figure 3.9). The Mouse Imaging 
Shuttle (MIS) contains the subject during image acquisition on the Quantum GX2 microCT Imaging 
System and the IVIS<Univ_8pt>® Spectrum Imaging System. The MIS transports the subject between the 
imaging systems without disrupting the subject position so that 3D volumetric data acquired on the 
Quantum GX2 microCT Imaging System can be precisely registered with the optical data obtained 
on the IVIS Spectrum Imaging System. 

The transfer bed replaces the acrylic beds supplied. A single mounting screw secures the transfer bed 
to the movable sample platform on the Quantum GX2 microCT Imaging System scanner. The bed 
has an anesthesia supply and exhaust tube attached that connects to the XGI-8 Gas Anesthesia System 
hoses. 

Figure 3.8  Tube Inlet

! CAUTION: Bind tubes and cables together to prevent cable disconnection that can be
caused by the inserted tubes or cables touching the electric table. 

! CAUTION: Image quality may be affected by contrast media or anesthesia on the bore
cover or the sample bed. If contrast media or anesthesia adheres to the bore cover or
sample bed, wipe it off before it hardens or dries out.

! CAUTION: Scavenging is recommended when using gas anesthesia. Be aware of air
ventilation requirements when using gas anesthesia.

Sample 
chamber

External 
device
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3.9 FMT Mouse Imaging Cassette
An optional adapter provides compatibility with the FMT mouse imaging cassette (Figure 3.10). The 
FMT Mouse Imaging Cassette contains the subject during image acquisition on the Quantum GX2 
microCT Imaging System and the FMT Imaging System. The cassette enables transport between the 
imaging systems without disrupting subject position so that 3D volumetric data acquired on the 
Quantum GX2 microCT can be precisely registered with the optical data.

Figure 3.9  Transfer Bed and Mouse Imaging Shuttle

Figure 3.10  FMT Mouse Imaging Cassette and Adapter

Anesthesia supply and exhaust hoses

Attachment screw

Mouse Imaging Shuttle 
(MIS)

Transfer bed

Transfer bed with MIS mounted in the Quantum GX2 
microCT Imaging System scanner

FMT Mouse Imaging Cassette Adapter

Adapter with FMT Mouse Imaging Cassette mounted in the 
Quantum GX2 microCT Imaging System scanner



4 Getting Started
Workflow Overview
Starting the Imaging System 

4.1 Workflow Overview
Table 4.1 presents an overview of acquiring CT data on the Quantum GX2 microCT Imaging System.

 

Table 4.1  Workflow Overview

Step See Page

1. Start the Quantum GX2 microCT Imaging System. See below

2. Warm up the Quantum GX2 microCT Imaging System (click the  button in the Control 
Panel).

40

3. Create and/or connect to a database. 29, 30

4. Create or select a sample and study where the image data (series) will be saved. 41

5. Set the scan conditions. 43

6. Place the anesthetized subject in the sample chamber and center the subject in the Xcapture 
window.

47

7. Start the CT scan. 51, 52, or 
55

8. View and analyze the 3D reconstruction. 65

9. Post-processing options:
 Reconstruct a subvolume or slice(s).
 Reconstruct the sinogram (image data).

Note: Post-processing analyses may be performed offline on a workstation not connected to 
the imaging system.See page 63 for required software, workstation requirements, and 
workstation setup.

58
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4.2 Starting the Imaging System
1. Turn on the Quantum GX2 microCT Imaging System by pressing the green power button (default 

user ID – "CTadmin", default password – "ct2admin").

2. Start the software by double-clicking the  icon on the desktop.

The Control Panel and Database window appear (Figure 4.2).

Figure 4.2 shows an overview of the Control Panel functions.

All image data are saved to a database. See Chapter 5 on page 29 for more details about 
databases.

If you have any concerns during the startup procedure, please contact PerkinElmer technical 
support (see page 4) for assistance.

Figure 4.1  Quantum GX2 microCT Imaging System

NOTE: The user ID "CTadmin" has administrator privileges on the computer.

Figure 4.2  Control Panel and Database Window at Startup

Power button

Control Panel Database window

D: drive space 
monitor bar

http://www.perkinelmer.com/tools/technicallibrarylandingpage
http://www.perkinelmer.com/tools/technicallibrarylandingpage
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Table 4.2  Control Panel

Item Description For More Details, See:

Scanner status Figure 6.1 on page 40

Choose a preset or custom scan configuration from this drop-
down list.

Table 6.2 on page 44

Actual voltage of the X-ray tube during a scan (top).

To edit the voltage for a scan, enter a value in the lower field 
or make a section from the drop-down list.

page 45

Actual current of the X-ray tube (top).

CT – The current setting for a scan.

Live – The current setting for a fluoroscopy/Live Mode scan. Acquisition in 
Fluoroscopy Mode on 
page 62

Dose (mGy)

Acquisition – Field of view options: 86, 72, 36 or 18 mm. 
Note: 36 mm is only available with the small bore cover.

Recon – The reconstruction field of view.

Voxel size – Voxel size determined by the software based on 
the acquisition FOV and reconstruction FOV.

Table 6.2 on page 44 for 
more information on scan 
modes.

X-ray filter selection Drop-down menu that is used to indicate which filter has been 
manually placed in the instrument (see Imaging With 
Different X-Ray Filters, page 64).

Click  to select respiratory gating.

Click  to select cardiac gating.

page 52

page 55

Available scan modes: Standard, High Speed, or High 
Resolution. 

Scan times vary with the scan mode (see Table 6.2 on 
page 44).

Table 3.2 on page 19

Filters for removing noise by combining pixels. Table 3.2 on page 19

Dose for a CT scan using that particular mode. This number 
changes based on the scan mode settings.

Displays the scheduled X-ray dose per unit 
time during a CT or fluoroscopy scan.

CT scan – Estimated exposure dose 
calculated from the actual irradiation time.*

Fluoroscopy scan – Estimated radiation 
dose, updated every second.

*See Meganck, J.A. and Liu, B. Mol Imaging Biol (2016). 
doi:10.1007/s11307-016-1026-x for information on estimated 
exposure dose and radiation dose.
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Use the  and  arrows to set the subject orientation.

Initialize – Moves the sample bed to the “0”position and

initiates manual control of the sample bed.

 – Actual z-axis position of the sample bed (into or 
out of the bore). Position information is available after you 
click Initialize).

 – To move the sample bed in/out of the bore,

select a distance (mm) from the drop-down list or enter a 
value, and click Set.

 – Click to move the bed in or out of the bore.

page 47

Click to begin X-ray tube warm-up. The Warm-Up button  

changes to the Live Mode button  after X-ray tube 

warm-up is complete. 

Click this button to view the subject in real time.

Starts a scan.

Emergency stop button. Click this button to abort acquisition 
and stop X-ray generation.

Closes the software.

Table 4.2  Control Panel (continued)

Item Description For More Details, See:

Shows the current gantry position 
and degree of rotation, 0 degrees in 
this example.

To manually rotate the gantry before 
scanning, select the degrees of rotation or 
enter a value, and click Set. 

Click Home pos. to return the gantry to 0 
degree rotation.



5 Working With Databases and Data
Creating a Database
Connecting to a Database  on page 30 

Data Organization  on page 31
Managing Data  on page 33
Managing Databases  on page 35
System Administrator Login/Logout  on page 37
Working With Data Offline  on page 37

5.1 Creating a Database
All image data (series) are saved to a local database. Each scan is stored in the folder D:\Data and 
the raw acquisition data are stored in Computer\Data (D:)\*. The database facilitates interacting with 
and managing data sets. 

To create a database:

1. Open the Database window by starting the Quantum GX2 microCT software (click the  icon 
on the desktop (Figure 5.1).

Figure 5.1  Database Window
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2. Click the New Database button  in the Database window. Alternatively, select File → New 
Database on the menu bar.

3. In the dialog box that appears:

a. Enter a name for the new database (Figure 5.2). 

b. Click Browse, and in the dialog box that appears, navigate to the drive where the database will 
be saved and click OK.

c. Click Create.

The new database will appear in the Database window.

5.2 Connecting to a Database
1. Click the Connect to Database button  in the Database window.

2. If the database name is listed the dialog box that appears, double-click the name. Alternatively, 
select the database name and click Connect (Figure 5.3).

If the database name is not listed in the dialog box:

a. Click Browse

b. Select a database in the dialog box that appears and click OK.

c. Click Connect.

Figure 5.2  Creating a New Database

Figure 5.3  Connecting to a Database
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5.3 Data Organization
The image data (series) in a database are associated with a study and a sample (Figure 5.4). A sample 
may include multiple studies and a study may include one or more series.

Customizing the Database View

You can select particular columns and data to display in the Database window.

To hide/show columns: 

1. Right-click a column header in the Database window (Figure 5.5).

2. Select Configure Display Columns on the shortcut menu that appears.

3. In the dialog box that appears, remove or add a check mark next to a column name that you want 
hide or show. Click OK.

Figure 5.4  Database Window

Series (image data)

Samples
A sample includes one or 
more studies. This example 
shows one sample which 
has two studies.

Studies
A study includes one or 
more "series" of image data.



Quantum GX2 microCT Imaging System Manual Chapter 5  |  Working With Databases and Data 32
To filter the data:

Select a filter from the Name, Study, and/or Series drop-down list (Figure 5.6).

Figure 5.5  Select Database Columns

Figure 5.6  Database Filters
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5.4 Managing Data
Reconstructed image data (*.vox) can be imported between databases or exported from the database 
to another location such as the desktop.

Importing Data

1. Select a save location (sample and study) for the data in the Database window. See page 41 for 
instructions on selecting a save location.

2. Click the  toolbar button. Alternatively, select File → Import File on the menu bar.

3. Select the data (*.vox) for import in the dialog box that appears and click Open.

The imported series appears in the Database window. The original data name is listed in the 
Series Description.

Exporting Data

1. Select the series for export in the Database window.

2. Click the  toolbar button. Alternatively, select File → Export File on the menu bar.

3. In the dialog box that appears (Figure 5.7), confirm the default name or enter a different name for 
the new folder where the data will be copied.

4. To change the folder path, click Browse and select a location in the dialog box that appears.

5. Select a file format from the drop-down list.

Figure 5.7  Export File

File Format Description

CT image with a SimpleViewer Exports the 3D reconstruction (.vox) along with the SimpleViewer. See 
page 68 for more details on the Viewer.

DICOM (16bit, Single page)

Tiff (16, Multi page)

JPEG

Bitmap

PNG

Exports individual slices in a file formats common for medical imaging. 
Exporting to DICOM format creates a folder of .dcm files, one file per 
slice. Exporting to Tiff format creates a single file which includes all of 
the slices.

AVI Exports the selected images in a video file format.

Data will be copied to this folder
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6. To export only a subset of the slices contained in an image, choose the “Limited” option and enter 
a range of slice numbers. Click OK.

Moving Data

You can move a series to a different sample and study.

1. In the database window, right-click the row of the series that you want to move and select Move 
Entry from the drop-down menu (Figure 5.8).

2. Click the destination sample and study.

3. Click Yes in the prompt that appears (Figure 5.9).

Deleting Data

1. Select a sample, study, or series in the Database window.

2. Right-click the row and select Delete Data on the shortcut menu.

Figure 5.8  Select Series Data

Figure 5.9  Move Entry Prompt

NOTE: Only the system administrator can delete data. See page 37 for instructions on system
administrator login/logout.

! CAUTION: Deleting data removes all reconstructed and raw images from the system.
The images cannot be recovered once the delete process is initiated.
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3. Click Yes in the confirmation message that appears.

5.5 Managing Databases

Copy a Database

Copying a database provides a convenient way to share data.

1. Connect to the database that you want to copy. (See page 30 for details on connecting to a 
database.)

2. Select File → Save Database as on the menu bar.

3. Enter a name for the new database in the dialog box that appears.

4. To change the save location:

a. Click Ref (Figure 5.11).

b. Select a folder in the dialog box that appears, and click OK.

5. Click Save.

Figure 5.10  Deleting Data

NOTE: Only the system administrator can copy a database. See page 37 for instructions on
system administrator login/logout.

Figure 5.11  Copying a Database
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Search a Database

1. Click the  toolbar button.

2. Enter a text string, choose the search options, and click Search.

Delete a Database

1. Connect to the database that you want to delete:

a. Click the Connect to Database button  in the Database window.

b. Select the database in the dialog box that appears.

2. Select File → Delete Database on the menu bar.

3. Click OK In the confirmation messages that appears.

Figure 5.12  Database Search Parameters

NOTE: Only the system administrator can delete a database (includes the associated studies and
series), study (includes the associated series), or series only. See page 37 for instructions on
system administrator login/logout. Do not delete a database using Windows Explorer.

! CAUTION: Deleting a database removes all reconstructed and raw images from the
system. The images cannot be recovered once the delete process is initiated.
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5.6 System Administrator Login/Logout
1. Select Settings → Login/Logout as Administrator on the menu bar.

2. Enter the administrator password in the dialog box that appears.

The default password is ct2admin.

3. Click Login (or Logout if logging out).

5.7 Working With Data Offline
Two different software packages are available for working with data offline.

 Quantum GX Viewer Pack Software – Display only software for viewing image data and 
reconstructed microCT images. 

 Quantum GX Image Analysis Software – Analysis and display software that enables you to 
reconstruct and view microCT images.

Workstation Requirements

Ensure that the offline workstation meets the requirements in Table 5.1. 

Figure 5.13  Login as Administrator

Table 5.1  Workstation Requirements for Offline Analyses

Requirement Software

Quantum GX Viewer Pack Quantum GX Image Analysis

Operating system Windows® 7 or 10 32-bit or 64-bit 
Home Edition or higher

Windows 7 Professional 64-bit or 
Windows10 Professional 64-bit

CPU Intel® Core i5 or i7 2.0GHz or higher Intel Core i5 or i7 3.0GHz or higher

Memory 4GB minimum 16GB minimum

Hard disc System drive (C drive) – 1GB or more 
free space 

 System drive (C drive) – 1GB or 
more free space 

 Data drive (D drive) – This drive is 
required for storage of raw image 
data. The drive should be 
formatted with a file system 
capable of handling single files 
larger than 10GB (e.g. NTFS) and 
have sufficient storage (at least 1TB 
is recommended).
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Workstation Setup

1. Manually create the folder "D:\RigakuApplicationData".

2. Install the Quantum GX Analysis Software on the analysis workstation using the software 
installer.

3. Launch the database.

Graphics card The following graphics cards are 
supported:
 NVidia GeForce GTX 680, 2048MB 

GDDR5
 NVidia GeForce GTX 770, 2GB 

GDDR5
 NVidia GeForce GTX 980, 4096 MB, 

256 bit GDDR5 (for example, EVGA 
GeForce GTX 980 4GB GAMING, 
Silent Cooling Graphics Card 04G-
P4-2980-KR)

Graphics board OpenGL2.0 or later, graphic memory 
of 1GB or more

 NVIDIA GeForce GTX680 or later
or

 Quadro K2000 or later
 Graphic memory 1.5GB or more 
 Driver Ver.378.49 or later (GeForce 

type)
or

 Driver Ver.376.62 or later (Quadro 
type)

USB port One or more USB2.0 ports.

Note: USB port for keyboard, mouse 
and one extra port required.

One or more USB2.0 ports.

Note: USB port for keyboard, mouse 
and one extra port required.

Monitor resolution 1920 × 1080 or more 1920 × 1080 or more

D drive Drive with sufficient storage (at least 
1TB is recommended) that is 
formatted with a file system capable 
of handling single files larger than 
10GB (e.g. NTFS)

RAM 16GB

NOTE: A hard drive labeled as "D:" is required and can be created as a partition on another hard
drive if necessary.

Table 5.1  Workstation Requirements for Offline Analyses (continued)

Requirement Software
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This creates a folder structure on the D: drive that matches the imaging system D: drive 
(Figure 5.14). Quantum GX Analysis Software only supports subvolume reconstructions using 
folder hierarchies that match what is on the imaging system workstation. 

4. Copy a database from the imaging system or data archive to an external medium, for example a 
USB external hard drive. See page 35 for instructions.

5. Go to "Data (D:)\RigakuApplicationData\RmCT2\CT_RawData" on the imaging system. Select 
and copy the raw data folder(s) of interest to an external medium. Each folder name includes the 
date and time of a scan (CR_YearMonthDay_HourMinuteSecond) (Figure 5.15). 

6. Copy the raw data folder(s) from the external medium to 
"D:\RigakuApplicationData\RmCT2\CT_RawData" on the analysis workstation.

Figure 5.14  Folder Structure on the Analysis Workstation

NOTE: Quantum GX Analysis Software only analyzes image data on the local workstation.

NOTE: Be sure to copy the data folder and its contents, not just the raw data. Otherwise the
workstation will not be able to process the data.

Figure 5.15  Select and Copy Raw Data Folder(s)



6 Image Acquisition
Imaging System Warm-Up
Select a Save Location  on page 41
Set Up Automatic Image Export  on page 43
Set the Scan Conditions  on page 43 

Place a Subject in the Sample Chamber  on page 47 

CT Scan Without Gating  on page 51
CT Scan With Respiratory Gating  on page 52
CT Scan With Cardiac Gating  on page 55
Reconstructing a Subvolume or Slice  on page 58
Acquisition in Fluoroscopy Mode  on page 62
Ring Reduction  on page 63
Imaging With Different X-Ray Filters  on page 64

6.1 Imaging System Warm-Up

Check the Control Panel to see if the imaging system requires warm-up (Figure 6.1). If the Control 
Panel is not open, click the  icon on the desktop.

NOTE: If the imaging system is not turned on, see Starting the Imaging System on page 26 for
instructions.

Figure 6.1  Control Panel

Warm-Up Required
X-rays are OFF

Click to begin 
warm-up

Warm-Up in Progress
X-rays are ON

Live Mode button 
appears after 

Warm-Up Complete
X-rays are OFF

Ready for acquisition 
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To warm-up the imaging system:

1. Confirm that the sample chamber is empty (no subject or sample bed is inside the sample 
chamber).

2. Close the imaging system door.

3. Click the Warm-up button  in the Control Panel. Click OK in the warning message that 
appears (Figure 6.2).

The X-ray tube begins the warm-up process and generates X-rays. The time required for warm-
up depends on how long it has been since the imaging system was last used (Table 6.1). X-ray 
tube status changes to “STANDBY” when warm-up is completed (Figure 6.1).

6.2 Select a Save Location
All image data (series) are saved to a database where the data are organized by sample and study 
(sample:study:series). See page 31 for more details on data organization. Before image acquisition, 
select a database and specify the sample and study where the series will be saved. You can save a 
series to a new or existing sample and a new or existing study within the sample.

NOTE: The Quantum GX2 microCT Imaging System does not generate X-rays unless the door
is properly closed and the safety interlock is engaged. There is an audible “click” when the
safety interlock properly engages as the door is closed.

! CAUTION: Do not open the imaging system door when X-rays are being produced (the
Control Panel displays “XRAY ON” and the X-ray indicator  is flashing). Opening the
door terminates the X-rays and aborts the warm-up process.

Figure 6.2  Warm-Up Warning Message

Table 6.1  Estimated Time Required for Warm-Up

Duration of Imaging System Disuse Approximate Time 
Required for Warm-Up

8 hours to 1 month 15 minutes

1 – 3 months 40 minutes

More than 3 months 2 hours

NOTE: The selected database drive must have at least 10GB free disk space available. If this
requirement is not met, the scan will not proceed.
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Set the Save Location:

1. Connect to a database or create a new database. (See Managing Databases page 9 for details).

2. Follow the instructions in Table 6.1 to select a sample and study for the series.

3. Enter the sample and/or study information in the dialog box that appears. Click Add. 

For example, edit the default sample name and enter a description of the sample.

Table 6.1  Setting the Save Location in the Database window

To Save the Series to a: Do One of the Following:

New sample and new study Click the  toolbar button.

or

Right-click the Database window and select New Sample on the 
shortcut menu.

or

Select Sample → New Sample on the menu bar.

Existing sample and new study Select the sample row and click the  toolbar button.

or

Right-click the sample row and select New Study on the shortcut

menu.

or

Select the sample row and select Sample → New Study on the

menu bar.

Existing sample and existing 
study

Select the study row and click the  toolbar button.

or

Right-click the study row and select Set Series Save Location on the 
shortcut menu.

NOTE: Depending on the method used to select the save location, the Add Sample or Add
Study dialog box may not automatically appear. To display them, right-click a selected sample
or study in the Database window and choose Update Data from the shortcut menu.

Figure 6.3  Enter Information About a New Sample and/or New Study

A sample identifier 
assigned by the 
software (cannot be 
edited)
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6.3 Set Up Automatic Image Export
After acquisition, DICOM images can be automatically exported to a user-selected location.

1. Select Setting Automatic → DICOM Export Settings in the Database window.

2. Put a check mark next to "Export DICOM file after each scan" in the dialog box that appears.

3. Choose the File path or VOX folder option and click Browse to select a folder. Click OK.

6.4 Set the Scan Conditions
Set the scan conditions by choosing a:

 Preset scan condition or specify custom scan parameter conditions in the Control Panel.

 Gating option if performing a gated CT scan.

Preset Scan Conditions 

1. Select a preset or custom scan setting from the Presets drop-down list (Figure 6.5).

 

Figure 6.4  Automatic DICOM Export Settings

NOTE: Custom scan settings saved to the system are also available in the Preset drop-down
list. See page 45 for instructions on creating custom scan settings.

Figure 6.5  Selecting a Preset Scan Condition

Choose a preset or custom 
scan configuration from 
this drop-down list
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Table 6.2  Preset Scan Configurations 

See Table 3.2 on page 19 for a description of the scan parameters. 
Note: FOV 45, 60 and 72 can be used with the small or large bore. FOV 25 and 36 can only be used with the small bore.

No. Menu Name kV CT 
µA

Live µA Acquisition 
FOV (mm)

Recon 
FOV (mm)

Scan Mode Scan 
Time

Display 
Settings

1 FOV72

High Speed, 8sec

90 88 40 72 72 High Speed 08 sec Soft

2 FOV72

Standard, 18sec

90 88 40 72 72 Standard 18 sec Soft

3 FOV72

Standard, 2min

90 88 40 72 72 Standard 02 min Soft

4 FOV72

High Resolution, 4min

90 88 40 72 72 High 
Resolution

04 min Off

5 FOV72

High Resolution, 14min

90 88 40 72 72 High 
Resolution

14 min Off

6 FOV60

High Speed, 8sec

90 88 40 72 60 High Speed 08 sec Soft

7 FOV60

Standard, 18sec

90 88 40 72 60 Standard 18 sec Soft

8 FOV60

Standard, 2min

90 88 40 72 60 Standard 02 min Soft

9 FOV60

High Resolution, 4min

90 88 40 72 60 High 
Resolution

04 min Off

10 FOV60

High Resolution, 14min

90 88 40 72 60 High 
Resolution

14 min Off

11 FOV45

High Speed, 8sec

90 88 40 72 45 High Speed 08 sec Soft

12 FOV45

Standard, 18sec

90 88 40 72 45 Standard 18 sec Soft

13 FOV45

Standard, 2min

90 88 40 72 45 Standard 02 min Soft

14 FOV45

High Resolution, 4min

90 88 40 72 45 High 
Resolution

04 min Off 

15 FOV45

High Resolution, 14min

90 88 40 72 45 High 
Resolution

14 min Off

16 FOV36

High Speed, 8sec

90 88 40 36 36 High Speed 08 sec Soft

17 FOV36

Standard, 18sec

90 88 40 36 36 Standard 18 sec Soft

18 FOV36

Standard, 2min

90 88 40 36 36 Standard 02 min Soft

19 FOV36

High Resolution, 4min

90 88 40 36 36 High 
Resolution

04 min Off
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Custom Scan Conditions

There are two ways to set custom scan conditions:

 Edit the scan parameters in the Control Panel (see below). These changes will not be saved to the 
system.

or

 Create and save a scan condition in the Menu Settings table (see page 46). The custom scan 
condition will be available in the Menu drop-down list of the Control Panel

To edit scan parameters in the Control Panel:

1. Select "Manual" from the Menu drop-down list.

2. Enter a custom voltage and current in the Control Panel (Figure 6.6).

3. Select FOV and Scan Mode. See Table 3.2 on page 19 for more details on these parameters.

20 FOV36

High Resolution, 14min

90 88 40 36 36 High 
Resolution

14 min Off

21 FOV25

High Speed, 8sec

90 88 40 36 25 High Speed 08 sec Soft

22 FOV25

Standard, 18sec

90 88 40 36 25 Standard 18 sec Soft

23 FOV25

Standard, 2min

90 88 40 36 25 Standard 02 min Soft

24 FOV25

High Resolution, 4min

90 88 40 36 25 High 
Resolution

04 min Off

25 FOV25

High Resolution, 14min

90 88 40 36 25 High 
Resolution

14 min Off

26 FOV72

High speed, whole body

90 88 40 72 72 High Speed Whole 
Body 

8 sec x 3

Off

27 FOV 60

High speed, whole body

90 88 40 72 60 High Speed Whole 
Body 

8 sec x 3

Off

Table 6.2  Preset Scan Configurations  (continued)

See Table 3.2 on page 19 for a description of the scan parameters. 
Note: FOV 45, 60 and 72 can be used with the small or large bore. FOV 25 and 36 can only be used with the small bore.

No. Menu Name kV CT 
µA

Live µA Acquisition 
FOV (mm)

Recon 
FOV (mm)

Scan Mode Scan 
Time

Display 
Settings
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To create a custom scan condition:

Create a custom scan condition by editing an existing scan condition or creating a new scan 
condition.

1. Select Options → Preset Modes on the Control Panel menu bar

The Menu Settings table appears (Figure 6.7). It lists the available scan conditions and their 
parameter settings.

Figure 6.6  Setting Custom Scan Conditions

See Table 4.2 on page 27 for more details on these parameters.

Figure 6.7   Preset Mode Settings

This is an example of the Preset Mode Settings display. 
Each user can have custom settings which will be included here

Actual voltage 
output of the X-ray 
tube during a scan

Enter the voltage 
for the scan

Actual current output of the 
X-ray tube during a scan

Select the current 
for the scan

Select the current 
for a fluoroscopy/
Live Mode scan

The scheduled X-ray 
dose per unit time 
during a CT or 
fluoroscopy scan
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2. To set scan conditions:

a. Enter a name (under the “Menu Name” column header).

b. Enter values for kV, CT µA, and Live µA.

c. Make a selection from the FOV and Scan Mode drop-down lists.

d. Click Save/OK.

The scan condition appears in the Menu drop-down list in the Control Panel.

3. To edit an existing scan condition:

a. Double-click a table cell and enter a new value.

b. Select a new value from a parameter drop-down list.

c. Click Save/OK.

The changes are saved to the system.

4. Select the scan condition from the Menu drop-down list in the Control Panel.

6.5 Place a Subject in the Sample Chamber
The imaging system is ready to acquire images after warm-up is complete. (See page 40 for more 
details on imaging system warm-up.)

1. Install an appropriate bore cover:

2. Manually slide the sample bed to the out-limit position (Figure 6.8). Alternatively, press the stage 
control buttons on the instrument front panel to move the sample bed.

Bore Name Diameter (mm) For Use With FOV

Sample 18 18, 36, 72, 86

Small 70 36, 60, 72

Medium 120 72, 86

Large 170 72

! CAUTION: If the small bore cover is installed, watch through the viewing window
of the sample chamber when using the motor control buttons on the front panel to
move the bed to make sure that the bed does not hit the bore cover.
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3. Place the anesthetized subject on the sample bed. 

If using the Mouse Imaging Shuttle, place the shuttle with the anesthetized subject on the sample 
bed. If needed, connect the gas anesthesia tubing. See the Mouse Imaging Shuttle Instructions 
(part no. 127820) for details on the Mouse Imaging Shuttle.

4. Push the sample table into the bore and slide the imaging system door closed so that the interlock 
properly engages.

5. Set the body orientation using the  or  arrows in the Control Panel. (Figure 6.9).
.

6. Turn on Live Mode by clicking the  button in the Control Panel.

The Xcapture window appears and shows the subject in real time (Figure 6.10).

Figure 6.8  Sample Bed at Out-Limit Position

Figure 6.9  Body Orientation

I

NOTE: Only the image data inside the bounding box are used to reconstruct the 3D volume.

! WARNING! If using the small bore cover with the mouse bed, watch through the
front viewing window when moving the bed right or left using the Stage X-axis
control buttons on the front panel (Figure 6.11). Make sure the bed does not hit the
bore cover.

Head first, 
prone (HFP)

Feet first, 
prone (FFP)

Head first, 
supine (HFS)

Feet first, 
supine (FFS)
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7. Click "Initialize" in the Control Panel and move the sample bed into the bore using one of the 
following methods.

 Z-axis controls on the front panel of the imaging system (Figure 6.11) – Press and hold the Fast 
button while you press the Z-axis left or right arrow.

 Use the stage control arrows  in the Control Panel (Figure 6.12).

 Move the sample bed a specific distance by entering a distance (mm) and click Set 
(Figure 6.12).

Figure 6.10  Xcapture Window

Respiratory gating is selected in this example.

Figure 6.11  Quantum GX2 microCT Imaging System Front Panel

Image data bounding box
Image data outside the 
bounding box are not used 
in the reconstruction.

Gating bounding box 
positioned around the 
diaphragm

Emergency OFF button Power ON/OFF button

Y-axis stage controls

X-axis stage controls Z-axis stage controls
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8. Check the subject position in the Xcapture window at the 0 degree gantry position:

a. Select "0" from the Rotation Control drop-down list.

b. Click Set (Figure 6.12).

c. If necessary, use the stage X-axis controls on the imaging system front panel to center the 
subject in the Xcapture window (Figure 6.12).

9. Check the subject position in the Xcapture window at the 90 degree gantry position:

a. Select "90" from the Rotation Control drop-down list and click Set (Figure 6.12).

b. If necessary, use the stage Y-axis controls on the imaging system front panel to center the 
subject in the Xcapture window (Figure 6.11).

10. Click the  button to turn off Live Mode and close the Xcapture window.

Figure 6.12  Control Panel

NOTE: Live Mode automatically times out after 150 seconds.

Gantry position 
at 0 degrees

Gantry position 
at 90 degrees

Use these controls to 
move the sample bed 
in or out of the bore
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6.6 CT Scan Without Gating

1. Click the CT Scan button  to begin the scan.

2. Click Yes in the confirmation message that appears (Figure 6.13).

X-rays are energized as indicated by the blinking voltage icon and the imaging system status box 
(Figure 6.14). The Xcapture window opens, then gantry rotation and image acquisition begin.

3D reconstruction automatically proceeds after acquisition is complete. 

The AutoViewer displays the 3D reconstruction (Figure 6.15). See Chapter 7 on page 71 for more 
information on viewing 3D reconstructions.

3. Remove the subject from the sample chamber after the Quantum GX2 microCT is in Standby 
mode.

IMPORTANT:  If you need to abort acquisition and stop X-ray generation, click the
emergency stop  button in the Control Panel.

Figure 6.13  CT Scan Confirmation Message

Figure 6.14  Control Panel and Xcapture Window During a Scan

! CAUTION: Do not remove or change the bore cover until the Quantum GX2 microCT
is in standby mode and the CT scan button  becomes available.

Gantry position

X-ray tube status = ON
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6.7 CT Scan With Respiratory Gating

1. Click the respiratory gating button .

2. Turn on Live Mode by clicking the  button in the Control Panel.

The Xcapture window appears and shows the subject in real time (Figure 6.16).

3. Adjust the ROI dimensions in the Xcapture window so that the ROI is positioned over the 
diaphragm.

4. Rotate the gantry 90 degrees. Ensure that the subject is within the field of view and the ROI is 
correctly positioned over the diaphragm.

5. Rotate the gantry back to 0 degree position.

Figure 6.15  AutoViewer

NOTE: A subvolume or slice(s) of a 3D reconstruction can be reconstructed at higher resolution
(smaller pixel size). See page 58 for more details.

IMPORTANT:  If you need to abort acquisition and stop X-ray generation, click the
emergency stop  button in the Control Panel.

If the AutoViewer does not 
automatically appear, confirm 
that the AutoView option is 
selected in the Database window.
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6. Check the respiratory signal trace in the Respiratory Synchronization window (Figure 6.17). 

Trace spikes represent diaphragm movements. Wait for the breath rate to stabilize with longer 
than 1000 ms ±1 sec between breaths.

7. Click the CT Scan button  to begin the scan and click Yes in the confirmation message that 
appears (Figure 6.13).

X-rays are energized as indicated by the blinking voltage icon and the imaging system status box 
(Figure 6.14). The Xcapture window opens, then gantry rotation and image acquisition begin.

Figure 6.16  Xcapture Window

Respiratory gating is selected in this example.

Figure 6.17  Respiratory Synchronization

Figure 6.18  CT Scan Confirmation Message

Image data bounding box
Image data outside the bounding box 
are not used in the reconstruction.

ROI positioned over the diaphragm

Time between breaths (ms) 
and breaths per minute (bpm)
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8. Review the raw data in the GetSynchronizedRaw window (Figure 6.19). To magnify the view, 
choose the Zoom option an use the left mouse button.

The goal is to obtain green squares with Y-axis values that are as uniform as possible. 

9. If you want to filter the data: 

a. Click Adjust (Figure 6.19). 

b. Enter a new Threshold value (%) in the dialog box that appears and click OK. See Table 6.3 
on page 55 for more details on gating parameters.

c. Click Reload and review the data. 

If you want to filter the data again, repeat step a to step c.

d. Click Reconstruct when you are satisfied with the data.

The 3D reconstruction proceeds. The AutoViewer displays the 3D reconstruction (Figure 6.15). 
See Chapter 7 on page 71 for more information on viewing 3D reconstructions.

Figure 6.19  GetSynchronizedRaw Window – Respiratory Gating

NOTE: If the Threshold value excludes too much data, a good 3D reconstruction will not be
produced.

NOTE: Gating parameter values cannot be edited after the data are reconstructed.

Represents the location 
of a selected frame 

Black trace shows a plot of the 
respiratory signal derived from the 
processing the ROI in the scan. 

Adjustable gating 
parameters
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6.8 CT Scan With Cardiac Gating

1. Click the cardiac  gating button.

2. Turn on Live Mode by clicking the  button in the Control Panel.

The Xcapture window appears and shows the subject in real time (Figure 6.16).

Table 6.3  Gating Parameters

Parameter Gating Type Description

Threshold Respiratory The threshold applied to the entire waveform to separate the 
baseline from the peaks. This allows for an initial separation of 
the relaxed state of the diaphragm (baseline) from the 
inspiration/expiration phases of diaphragm motion (peak). 

Inspiratory threshold Respiratory A secondary threshold that further refines point selection 
above the initial threshold.

Reducing this threshold reduces the number of points on the 
waveform selected as 'end inspiration' points. This can help 
identify the transition point in diaphragm motion between the 
inspiration and expiration phases. However, fewer points may 
also lead to a noisier image reconstruction.

Expiratory threshold Respiratory A secondary threshold that further refines point selection 
below the initial threshold.

Reducing this threshold reduces the number of points on the 
waveform selected as 'end expiration' points. This can help 
refine selection of the resting phase from the inspiration/
expiration phases. 

Rising invalid frames Respiratory The number of frames to ignore on the rising (inspiration) side 
of the peak.

Falling invalid frames Respiratory The number of frames to ignore on the falling (expiration) side 
of the peak.

Cardiac Cutoff Frequency Cardiac Frequency (Hz) that is used to separate the cardiac portions of 
the waveform from background signals. Frequencies above 
this value are considered part of the cardiac signal. This is 
related to the heart rate (for example, 300 beats per minute = 5 
Hz).

IMPORTANT:  If you need to abort acquisition and stop X-ray generation, click the
emergency stop  button in the Control Panel.
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3. In the Xcapture window, adjust the ROI dimensions to position it over the apex of the heart and 
diaphragm.

4. Rotate the gantry 90 degrees. Ensure that the subject is within the filed of view and the ROI is 
correctly positioned.

5. Rotate the gantry back to 0 degree position.

6. Check the respiratory and cardiac signal trace in the Respiratory synchronization window 
(Figure 6.21). 

The large trace spikes represent diaphragm movement. The smaller spikes in between represent 
cardiac movement. Ensure that the cardiac signal is as visible as possible (Figure 6.21). It may 
be possible to improve the signal visibility by adjusting the ROI position. 

Wait for the breath rate to stabilize with longer than 1000 ms ±1 sec between breaths.

7. Click the CT Scan button  to begin the scan.

Figure 6.20  Xcapture Window

Figure 6.21  Respiratory Synchronization

Image data bounding box
Image data outside the 
bounding box are not 
used in the 
reconstruction.

Position the ROI over 
the apex of the heart 
and diaphragm

Diaphragm motion signals Cardiac motion signals

Time between breaths (ms) 
and breaths per minute (bpm)
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8. Click Yes in the confirmation message that appears (Figure 6.13).

X-rays are energized as indicated by the blinking voltage icon and the imaging system status box 
(Figure 6.14). The Xcapture window opens, then gantry rotation and image acquisition begin.

Progress indicators for image processing appear (Figure 6.23). The AutoViewer displays the 3D 
reconstruction (Figure 6.15) after processing is complete. See Chapter 7 on page 71 for more 
information on viewing 3D reconstructions. 

9. Review the raw data in the GetSynchronizedRaw window (Figure 6.24). To magnify the view, 
choose the Zoom option and use the left mouse button.

The goal is to obtain green squares with Y-axis values that are as uniform as possible. 

Figure 6.22  CT Scan Confirmation Message

Figure 6.23  Processing Progress for Images Corresponding to 
Diastolic and Systolic Phases of the Cardiac Cycle

Figure 6.24  GetSynchronizedRaw Window – Cardiac Gating

Represents the location 
of a selected frame 

Black trace shows a plot of the 
respiratory signal derived from the 
processing the ROI in the scan. 
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10. If you want to filter the data: 

a. Click Adjust (Figure 6.24). 

b. Enter new values for Lower Breath (%) and/or Cardiac Cutoff Frequency (Hz) in the dialog 
box that appears and click OK. See Table 6.3 on page 55 for more details on gating 
parameters.

c. Click Reload and review the data. If you want to filter the data again, repeat step a to step c.

d. Click Reconstruct when you are satisfied with the data.

The 3D reconstruction proceeds. The AutoViewer displays the 3D reconstruction (Figure 6.15). 
See Chapter 7 on page 71 for more information on viewing 3D reconstructions.

6.9 Reconstructing a Subvolume or Slice

Subvolume Reconstruction

1. Load the data (double-click a thumbnail or series row in the Database window) and click .

An ROI on the images in the Viewer (Figure 6.25).

2. Move and resize the ROI so that it outlines the image data for reconstruction. 

3. Click .

A reconstruction progress indicator appears and the AutoViewer displays the CT image when 
reconstruction is complete. The image is added to the database (for example, if the series ID is 
"12", subvolume reconstructions will be named consecutively as 12.001, 12.002, and so on).

The Sub/Slice Region window shows the reconstructed subvolume within the context of the 
original image (Figure 6.26). 

NOTE: If the gating parameter values exclude too much data, a good 3D reconstruction will
not be produced.

NOTE: Gating parameter values cannot be edited after the data are reconstructed.

NOTE: If you will be performing subvolume reconstruction offline, ensure that the workstation
meets the requirements in Table 5.1 on page 37. Set up and copy image data to the workstation
following the instructions on page 38.
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Figure 6.25  Selecting Image Data for Reconstruction

Figure 6.26  Reconstructed Subvolume

ROI
Drag the ROI 
to move it 

Drag a corner to 
resize the ROI

ROI outlines the 
reconstructed subvolume

Reconstructed subvolume
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Slice(s) Reconstruction

1. Load the data (double-click a thumbnail or series row in the Database window).

2. Click the  button.

The transaxial view becomes the main view (Figure 6.25).

3. Choose a slice by doing either of the following:

 Click the  button and scroll through the slices using the mouse scroll wheel.

 Drag the red crosshair (Figure 6.28).

NOTE: If you will be performing slice reconstruction offline, ensure that the workstation meets the
requirements in Table 5.1 on page 37. Set up and copy image data to the workstation following
the instructions on page 38.

Figure 6.27  Change to Transaxial View

Figure 6.28  Selecting a Slice Using the Crosshair

Clicking this 
button makes 
transaxial view the 
dominant view

Drag the crosshair 
to select a slice
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4. Click the  button.

An ROI appears on the image (Figure 6.32). ROI size and position can be adjusted to select a 
portion of the slice for reconstruction.

5. Confirm the defaults or enter new values for slice thickness, slice pitch (distance between slices), 
number of slices to reconstruct.

6. Click the  button.

A reconstruction progress indicator appears and the AutoViewer displays the CT image when 
reconstruction is complete. The image is added to the database (for example, if the series ID is 
"12", slice reconstructions will be named consecutively as 12.001, 12.002, and so on).

The Sub/Slice Region window shows the reconstructed slice(s) within the context of the original 
image (Figure 6.30). 

Figure 6.29  ROI on Image

Figure 6.30  sub/Slice Region window

ROI
Move the ROI by dragging it

Drag a corner to resize 
the ROI

Reconstructed slice Original image with ROI and selected slice
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6.10 Acquisition in Fluoroscopy Mode 
In fluoroscopy mode, a range of user-selected frames can be viewed as a movie (scrolling through 
2D images) and stored in the image database.

1. Confirm the current save location or select a new save location (see page 41 for details).

2. Put the subject in the sample chamber and set the scan conditions. See Place a Subject in the 
Sample Chamber on page 47 and Set the Scan Conditions on page 43 for more details.

3. In the X-Capture window, move the slider to the first frame of the movie and click Start 
(Figure 6.31). Move the slider to the last frame of the movie and click End.

4. Click Play to scroll through the selected frames.

5. Click Movie to save the frames as a video in the current save location.

Saving an Image

A single frame in the Xcapture window can be saved as a “snapshot” and stored in the database.

1. Select a frame using the slider in the Xcapture window.

2. Click Photo.

This saves the snapshot to the current save location.

Figure 6.31  Xcapture Window and Options for Acquisition and Viewing

Slider Select acquisition and viewing options 
from the Xcapture window Options menu
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6.11 Ring Reduction
The ring reduction algorithm helps reduce image artifacts and is turned on by default. Figure 6.32 
shows example images of before and after ring reduction.

Sometimes ring reduction may result in image artifacts (Figure 6.33). The artifacts are usually minor. 
However, if they are unacceptable, you can turn off ring reduction and repeat the acquisition.

Figure 6.32  Images With Example Ring Artifacts

Figure 6.33  Example Image Artifacts Resulting From Ring Reduction

Before Ring Reduction After Ring Reduction

Ring 
artifact

Ring 
artifact

Ring artifact
Ring artifact
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To turn off ring reduction:

1. Select Options → Ring Reduction Settings in the Control Panel (Figure 6.34).

2. Remove the check mark next to the scan technique that was used during acquisition and click OK.

6.12 Imaging With Different X-Ray Filters
The Quantum GX2 microCT comes with five changeable X-ray filters which allow you to optimize 
imaging protocols. 

To change the X-ray filter:

1. Select the filter from the control panel.

2. Remove the imaging bore cover.

3. Manually change the filter in the filter chamber inside the Quantum GX2 microCT imaging bore.

4. Replace the bore cover and set up the imaging scan.

Figure 6.34  Turning Off Ring Reduction



7 Viewing Images
Previewing Data
AutoViewer  on page 66
Viewer and SimpleViewer  on page 68
Viewing a Z-Axis Slice  on page 71

7.1 Previewing Data
The Database window provides previews of 3D reconstructions.

Table 7.1  Previewing Data in the Database Window

Select: To Preview:

Sample The series from all studies under the sample (Figure 7.1).

Study All series in the study.

Series Series

Figure 7.1  Previewing Data in the Database Window

Select the Immediate Review 
option to automatically 
display a 3D reconstruction in 
the AutoViewer after 
acquisition. See page 66 for 
more details on the 
AutoViewer.

Series and scan conditions in 
the selected study and sample

Series thumbnails in the 
selection. If the selection 
includes multiple series, 
click one of the thumbnails 
to display in the preview 
pane above.

Choose the AutoPlay 
option to view a playback 
of the slices in the 3D 
reconstruction. 
Alternatively, uncheck the 
AutoPlay option and move 
the slider to view a 
particular slice. 

Select a study 
and sample 
from the study
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View the data using one of the CT viewers (Table 7.2).

7.2 AutoViewer

Table 7.2  CT Viewers

Viewer Name Description See 
Page

AutoViewer The AutoViewer automatically appears after a scan and 3D reconstruction 
are completed. The AutoViewer enables you to:
 View 2D images (slices) in the x, y, or z-planes.
 Select other image data (.vox) for viewing.
 Print the current AutoViewer display.

Below

Viewer Displays 2D image data. Double-click a series in the Database window to 
open the data in the Viewer. Alternatively, select a series and click the Run 
Viewer toolbar button . Use this viewer to visualize the 3D anatomical 
planes and perform basic 2D measurements.

68

3D Viewer Enables rendering of a 3D reconstruction (classifying the data). 71

NOTE: 2D image data and 3D reconstructions can be viewed offline on a workstation not
connected to the imaging system. See 

NOTE: If the AutoViewer does not automatically appear after reconstruction, confirm that the
Immediate Review option is selected in the Database window (Figure 7.1).

Figure 7.2  AutoViewer

Drag the crosshairs to select 
a slice location in the x, y, 
and z-axis planes. 
Alternatively, use the middle 
mouse button to scroll 
through the slices within a 
viewing plane.
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Table 7.3  AutoViewer Menu Commands

Menu Command Description

File → Import Opens a dialog box that enables you to select another .vox file for viewing.

File → Print Opens a dialog box that enables you to print the current AutoViewer display.

Setting → CT number 
adjustment

Opens a dialog box that enables you to calibrate the Hounsfield Unit scale.

Setting → System 
Configuration

Choose this option to view the function key associations for quickly changing 
the window and level settings for image viewing.

View → Status Bar Choose this option to show the x, y-coordinates of the mouse arrow in the 
AutoViewer window as well as the opacity value ("VAL").

View → Horizontal View Displays the x and y-axis views in a vertical orientation.

View → Vertical View Displays the x and y-axis views in a horizontal orientation.
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7.3 Viewer and SimpleViewer
The Viewer provides tools for 2D image display and analysis. 

To open data in the Viewer, double-click a thumbnail or series row in the Database window. Multiple 
series can be open in the Viewer at the same time.

NOTE: If you will be viewing 2D images offline, ensure that the workstation meets the
requirements in Table 5.1 on page 37. Set up and copy image data to the workstation following
the instructions on page 38.

Figure 7.3  Viewer Window

Table 7.4  Viewer Window

Item Description

Image Selection Click to import other CT data (*.vox) into the Viewer.

Opens the Database window.

Switches between images in the database.

Click to open the next database image in the same instance of the Viewer.

Click to open the previous database image in the same instance of the Viewer.

Analysis Opens the optional 3D Viewer. 

Image Control Scrolls through slice images in a windowpane using the mouse wheel.

Translates the slice image in the windowpane.

Rotates the slice image (within a plane).

Scales the slice image.
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Image Control Magnifies a selected area of the slice image. Right-click to select a different magnification (2x, 
5x, or 10x). Alternatively, click the  button the to change magnification.

Changes the window and level settings to change the image display. Use the keyboard up or 
down arrows. Alternatively, press and hold the mouse button while you drag the mouse up or 
down in a windowpane.

Reverses the gray scale color table. Click the  button again to return to the default gray scale 
color table.

Show or hide the x and y-axis crosshairs.

Show or hide a scale bar in the windowpanes.

Toggles between a horizontal or vertical slice orientation.

Makes the transaxial view the main view in the Viewer.

Resets to the default slice view or the default display if the image has been rotated, translated, 
or scaled

Image Display 
Settings

 

Click the  button to turn the mask off or on. Masks all voxels with gray scale value below the 
threshold value entered in the field.

Specifies a range of grayscale values for image display. Modify the range by editing the values in the 
fields. Click the  button to turn the feature off or on.

When a mask is applied using the  button (generates a purple mask), click the  button to 
mask additional voxels at the edges of the mask. This can help sharpen visualization at edges 
such as around the animal skin.

When a mask is applied using the  button (generates a green mask), click the  button to 
remove single pixel noise from the thresholded mask.

Enables you to select a 3D filter that removes noise by combining pixels and displaying the 
average intensity of the selected pixels:

EDGE – Enhancement filter that sharpen edges in the image and improves visualization of small 
features.

BONE – Enhancement filter that sharpens edges around high contrast objects such as bone.

ORIGINAL – Does not apply a filter.

SOFT – Applies a 3 x 3 x 3 averaging filter.

SMOOTH – Applies a 5 x 5 x 5 averaging filter.

Click to select options for viewing a Z-axis slice. See page 71 for more details.

Table 7.4  Viewer Window (continued)

Item Description

Area within the bounding 
box is magnified.

Magnified image area
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Reconstruction 
Options

Places an ROI on an image that will be used to select the image data for reconstruction.

Places an ROI on an image that will be used to select the image data for reconstruction

Pixel Size – Pixel dimensions. 

Slice Thickness – Voxel dimensions.

Slice Pitch – Distance between slices.

Number of Slices – The number of slices to reconstruct

Starts the reconstruction.

Measurement 
Tools

Click and drag to draw a measurement cursor on an image. Right-click a measurement cursor to 
delete the selected cursor or all cursors.

Draws a rectangular ROI on an image. Right-click an ROI to delete the selected ROI or all ROIs.

Draws a circular ROI on an image.

Displays a line graph of pixel intensities along a line segment drawn on an image.

1. Select a slice view.
2. Click the  button.

The Line Profile window appears.

3. Press and hold the mouse button while drawing a line segment on the image.
The Line Profile graph shows the pixel intensities along the line segment.

4. Drag either end of the line segment to resize or reposition the line segment.
The graph is automatically updated.

5. Click the  button again to turn off and close the line profile graph.

Opens a dialog box that enables you to insert a comment on an image. To add a comment to an 
image:

1. Select a slice view.
2. Click the  button.
3. Enter text and click OK in the dialog box that appears.
4. To resize or reposition the arrow, drag the arrow tip or the arrow end. To move the arrow, 

drag the entire arrow.
5. To delete a comment or all comments, right-click a comment and select a delete option from 

the shortcut menu.

Image Save Opens a Save As dialog box that enables export of the 3D reconstruction (.vox).

Copies the image to the system clipboard.

X = Cross hair location in the X-plane.

Y = Cross hair location in the Y-plane.

VAL = Grayscale value at the crosshair location.

Table 7.4  Viewer Window (continued)

Item Description
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Viewing a Z-Axis Slice

1. Click the  button in the Viewer.

2. Choose viewing options in the dialog box that appears and click OK (Figure 7.4).

 Thickness – 2, 4, 8, 12, or 16 slices

 MIP Type (intensity value of each pixel along the Z-axis that will be displayed) – Max, Min, 
or Average intensity

Figure 7.4  Z-axis Viewing Options

Figure 7.5  Viewer Window

Figure 7.6  Example Z-axis Slice Images

Z-axis slice

Maximum intensity Average intensity Minimum intensity
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7.4 3D Viewer
The 3D Viewer provides tools for rendering 3D reconstructions (classifying the image data and 
visualization) and viewing the 3D reconstruction from different perspectives. The volume rendering 
controls provide a histogram-based method for classifying the 3D reconstruction.

To open the 3D Viewer:

1. Double-click a thumbnail or series row in the Database window.

2. Click the  button in the Viewer that appears, 

The Volume Rendering Control Panel and 3DViewer window appears (Figure 7.7). 
3DViewer has two modes:

 Segment mode – Visualization mode that allows you to add multiple components which 
highlight different portions of an image.

 Artistic mode – Visualization mode that applies a colormap to improve viewing of the 
grayscale data.

NOTE: If you will be viewing 3D reconstructions offline, ensure that the workstation meets the
requirements in Table 5.1 on page 37. Set up and copy image data to the workstation following
the instructions on page 38.

Figure 7.7  3DViewer and Volume Rendering Control Panel – Segment Mode

Figure 7.8  3DViewer and Volume Rendering Control Panel – Artistic Mode

Click to change to artistic mode.

Click to change to segment mode.
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Table 7.5  Volume Rendering Controls

Item Description

Preset Rendering Selection 
Segment Mode

Allows you to define components using a monochromatic color table.

Preset Rendering Selection 
Artistic Mode

Choose from a selection of preset color tables. 

Component Selection Tools for classifying the image data. See page 76 for more details.

This button is available when the 3D Viewer is in artistic mode. Click 
to change volume rendering and controls to segment mode.

This button is available when the 3D Viewer is in segment mode. Click 
to change volume rendering and controls to artistic mode.

Image Control Click a blue arrow to rotate the 3D reconstruction 90° about the x, y, or 
z-axis.

To freely rotate the 3D reconstruction about the x or y-axis:

1. Click the  button.
2. In the 3DViewer, press and hold the mouse button while dragging 

the mouse.

Muscle Bone

Rainbow

Vascular 
Vessels and 
organs are blue.

Grayscale
Lighter color 
palette than 
monochrome.

Cardiac

Spectrum Perfusion 
For blood 
perfusion.

Green Purple Monochrome
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Click an arrow to rotate the 3D reconstruction about the z-axis. To 
freely rotate about the Z-axis:

1. Click the  arrow, then click an image.
2. Press and hold the mouse key while moving the mouse.

Translates the slice image in the windowpane. Click the  button to 
return to the default view.

Scales the slice image.

Show or hide the x and y-axis crosshairs.

Show or hide the perspective indicator in the 3D Viewer.

Opens the Tool Box with controls for setting shading parameters and 
the level of details in static and moving images in the optional 3D 
Viewer. See 

Table 7.7 on page 79 for more details on the Tool Box.

Resets to the default slice view or the default display if the image has 
been rotated, translated, or scaled.

Filter Allows you to select and apply a filter to improve the visibility of edges 
in View and 3D Viewer.

Clipping Use these controls to “cut” and remove voxels from the 3D 
reconstruction.

Hides all voxels above the y-axis crosshair.

Hides all voxels to the left of the x-axis crosshair.

Table 7.5  Volume Rendering Controls (continued)

Item Description

Y-axis crosshair

X-axis crosshair
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Hides all voxels that are above the intersection of the x and y-axes (the 
axis coming out of the monitor).

Adds/removes voxels to the display after it has been cut using the , 
, or  button. After the 3D reconstruction has been cut in the x, y, 

or z-plane, click the Slice button. To add or remove voxels from the 
display, click and hold the mouse button while dragging the mouse 
across the image.

Undo button that reverses the “cuts” that were made (unhides the 
voxels). Performs the undo action in a step-by-step reverse order (the 
last cut is the first reversed, and so on).

End Opens a dialog box that enables you to export the 3DViewer display 
to a graphic file or a movie.

Table 7.5  Volume Rendering Controls (continued)

Item Description
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Classifying Image Data Using the 3D Viewer

The 3DViewer initially displays image data with a default air-noise boundary that identifies bone. 
Use the volume rendering controls to create and visualize additional intensity ranges or “parts”, for 
example, a particular type of soft tissue.

The histogram in the volume rendering controls represents the distribution of voxel intensities in the 
3D reconstruction and their color-opacity values. The goal of classification is to set color and opacity 
values for different intensity ranges so that regions of the volume that are of interest appear opaque 
and unimportant regions are hidden (the voxels are transparent).

To classify a part of the data:

1. Click the Add Part button  (Figure 7.10).

A new partition appears in the histogram. The new part name is added to the part list.

NOTE: This section explains how to classify data while in segment mode. The steps are the same
in artistic mode.

Figure 7.9  Voxel Histogram

Figure 7.10  Adding a Part to the Histogram

Click to resize the histogram X-axis.

Click the  button to switch the 
histogram between a linear or log Y-axis.

Voxel color table and opacity

Voxel intensity

“Bone”

Part list

Partition tools

Click to add a partition New “Part 2”
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2. Modify the partition to visualize the tissue of interest using the tools partition tools (Table 7.6). 
To use a tool:

a. Click the button, then click the histogram. 

b. Press and hold the mouse button while dragging the mouse left/right or up/down

Managing Classified Data

You can edit the color table and name that are assigned to different parts of the data, and change the 
display order of multiple, overlapping data parts. For example, if there are two data parts that overlap, 
the 3DViewer displays the first part in the list on top of the second part.

To change the color table for particular data:

1. Double-click the part name and select Color on the shortcut menu., 

2. Select a color or define a custom color in the Color Palette that appears. Click OK.

Table 7.6  Partition Tools

Tool Functions

Moves (translates) the partition up/down or left/right on the histogram.

Adjusts the angle of the left and right portions of the partition. If the top of the partition is 
narrow, this can result in partition forming a point (as shown). For example:

Adjusts the partition height. Adjusts the width at the bottom only. For example:

Adjusts the partition height and moves the left side of the partition. For example:

Adjusts the partition height and moves the right side of the partition. For example:
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To edit a part name:

1. Double-click the part name and select Rename on the shortcut menu.

2. Enter a name in the dialog box that appears. Click OK.

To show/hide or delete parts:

1. To hide a part, remove the check mark next to the part name.

2. Put a check mark next to the name to show the part (Figure 7.12).

3. To delete a part, double-click the name and select Delete on the shortcut menu that appears.

Figure 7.11  Selecting a Color Table

Figure 7.12  Select Parts to Show or Hide

Select the parts 
to display in the 
3DViewer
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3DViewer Display Options

You can adjust the detail level and shading that is used to render the 3D reconstruction in the 
3DViewer.

1. Click the  button to access the tools for setting shading and detail level.

2. Adjust the settings using the sliders.

Changing shade settings automatically updates the 3DViewer display.

Table 7.7  Tool Box Settings

Item Description

Shader Setting

Ambient Controls the intensity of the 'ambient light” that is applied to the rendering. 
Setting range: 0.0 to 1.0, dim to bright

Diffuse Sets the level of "focus' of the simulated light on the rendering. Setting range: 
1 = most focused, resulting in the brightest rendering; 0 = the dimmest.

Specular Affects the lens that is used for light in the rendering. Setting range: 0 to 1.0, 
dim to bright.

Specular Power Affects the "lens" used for the visual rendering. Setting range: 0 to 50. The 
results are dependent on the 'Specular' setting.

Level of Detail

Still Level of Detail Sets the quality of the visual rendering that is 'still' (not moving). Highest 
quality = 1.0. Decreasing this number reduces the quality of the rendering and 
also reduces the computational burden.

Moving Level of Detail Sets the quality of the visual rendering during rotation, translation or 
zooming. The highest quality is set relative to the 'still' quality. Decreasing this 
number will reduce the quality of the rendering during movement and can be 
used to speed up reformatting of the rendering.



8 Care and Maintenance
Surveying the Quantum GX2 microCT for Radiation Leakage
Maintenance & Safety Checks
Cleaning the Quantum GX2 microCT  on page 81

8.1 Surveying the Quantum GX2 microCT for Radiation Leakage
PerkinElmer recommends, and some local government agencies may require, an X-ray leakage safety 
test be performed under the following conditions:

 Every 12 months

 After PerkinElmer performs maintenance or service

 After any abnormal condition that could impair any of the safety systems. For example, the light 
box door becomes difficult to open or close.

Conducting the X-Ray Radiation Survey

A radiation leakage test is a complicated matter requiring sensitive and expensive equipment. Some 
states or localities may require special training and certification to perform the test. Contact 
PerkinElmer technical support for information regarding these tests or for scheduling a PerkinElmer-
trained person to conduct the survey as part of an overall safety check.

8.2 Maintenance & Safety Checks

Daily/Weekly Safety Checks

Perform the following safety checks on a daily basis.

1. Verify that the door interlock is in good repair.

2. Verify that the key switch functions properly.

3. Verify that the "X-Ray On" indicators are functioning properly.

The following safety checks should be performed on a weekly basis.

1. All checks performed on a daily basis.

2. Inspect all screws holding the door shield and make sure that none are loose.

NOTE: There are no user-performed maintenance procedures.
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Monthly Safety Checks

Perform the following safety checks every month.

1. All safety checks performed on a daily basis.

2. Activate the "X-Ray Emergency Off" switch to verify operation. 

All indication of X-ray generation should cease when the switch is pushed in.

3. Reset the X-Ray Emergency Off switch by turning the red knob clockwise.

The knob should pop out.

4. Restart X-ray generation from the Quantum GX2 microCT Imaging System control software.

Annual Safety Checks

Perform the following safety checks every 12 months.

1. All safety checks that are conducted on a daily, weekly, and monthly basis.

2. A full radiation survey conducted by a qualified person.

8.3 Cleaning the Quantum GX2 microCT

Approved Cleaning Solutions

The compounds shown in Table 8.1 do not damage the internal finish of the Quantum GX2 microCT 
imaging chamber and are suitable for use as cleaners, if required. Do not use any solution not 
included in this list. In particular, avoid strong bases, bleach, or acids that may potentially damage 
the unit and compromise its operation.

NOTE: X-rays will need to be generated when performing this test.

IMPORTANT: Do not spray cleaning solutions in the sample bore. Gently wipe the bore
surfaces as described on page 82.

Table 8.1  Acceptable cleaning solutions for the Quantum GX2 microCT sample bore

Cleaning Solution Manufacturer

Cidexplus® Solution (3.4% glutaraldehyde) Johnson & Johnson Medical

70% methyl alcohol/30% deionized water solution

70% ethyl alcohol/30% deionized water solution

Sporicidin® Sterilizing Solution (1.56% phenol) Sporicidin International

Clidox-s® Disinfectant Pharmacal Research Laboratories, Inc.

NOTE: PerkinElmer makes no claims as to the sterility of the Quantum GX2 microCT imaging
chamber after using the solutions in Table 8.1. Please refer to the manufacturer’s literature for
information as to the applicability of the compound for the organism of interest.
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It is recommended that you use a lint-free wipe, such as Scott Pure® wipe or a Kaydry EX-L® wipe 
to minimize the presence of particulate matter in the imaging chamber.

After saturating a lint-free wipe, clean the internal surfaces using a gentle circular motion. Use extra 
care when cleaning the radiolucent insert since it is a delicate assembly. Do not pour or spray the 
solution directly onto internal surfaces. Rinse surfaces using a wipe saturated with sterile deionized 
water. Do not allow puddles of water to remain on the surfaces.

Consider dedicating a Quantum GX2 microCT for immunodeficient animals to remove the risk of 
cross-contamination.



9 Legal Notices
Introduction
Limited Warranty
Trademarks  on page 84
Disclaimers  on page 85

9.1 Introduction
This manual is provided to you by PerkinElmer Health Sciences, Inc. ("PEHS") on behalf of itself 
and its affiliates, including but not limited to, Caliper Life Sciences, Inc. ("Caliper"). PEHS and 
Caliper are referred to collectively throughout this manual as "PerkinElmer". Section 9.2 below 
provides the standard limited warranty for the System and any associated software

9.2 Limited Warranty
A. Caliper Life Sciences, Inc. ("Caliper") provides the following limited warranty for each new 

Quantum GX2 microCT ("System") as follows ("Limited Warranty"):

i. PerkinElmer warrants that the System shall substantially conform to its published specifications 
existing at the time of purchase for a period of one (1) year following delivery to, and installation 
of, the System to the original customer, purchaser, or user ("Customer"). This Limited Warranty 
for the System extends only to the Customer. This Limited Warranty is not assignable or 
transferable to any successor, without the express written permission of PerkinElmer, which may 
be withheld in its sole discretion.

ii. During the Limited Warranty period, PerkinElmer will repair or replace, at PerkinElmer's sole 
option, any defective parts if such repair or replacement is needed because of System malfunction 
or failure during normal usage in accordance with the instructions in this manual. Repairs and 
replacements under the Limited Warranty will be made at PerkinElmer's expense. Parts replaced 
during this Limited Warranty period may be retained by PerkinElmer, at its sole option. All 
replacement parts will be warranted for the longer of the remaining term of the original Limited 
Warranty period, or for thirty (30) days from the date of replacement. PerkinElmer's limit of 
liability under the Limited Warranty shall be the purchase price of the System.  PerkinElmer shall 
not be liable for any other losses or damages. These remedies are the Customer's exclusive 
remedies for breach of this Limited warranty.

iii. No coverage or benefits shall be provided under this Limited Warranty if any of the following 
conditions apply:

a. The System has been subjected to abnormal use, abnormal conditions, unauthorized 
modifications (e.g., unauthorized installation of hardware or software), unauthorized repair or 
servicing, misuse, neglect, abuse, accident, alteration, any use inconsistent with or in 
contradiction to the instructions in this manual, or other acts which are not the fault of 
PerkinElmer.

b. PerkinElmer was not advised in writing by the Customer of the alleged defect or malfunction 
of the System within ten (10) days after the expiration of the applicable Limited Warranty 
period.

iv. If a problem develops during the Limited Warranty period, the Customer shall contact 
PerkinElmer technical support for assistance immediately following discovery of the problem.

B. The following Limited Warranty provided by PerkinElmer is the sole and exclusive warranty  
applicable to the software provided with the System ("Software"):
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i. PerkinElmer warrants for a period of ninety (90) days that such software will conform to 
PerkinElmer's or the Software manufacturer's program manuals current at the time of shipment 
to Customer when properly installed; provided, however, that PerkinElmer does not warrant that 
the operation of the software will be uninterrupted or error-free. This Limited Warranty for the 
Software extends only to the Customer. This Limited Warranty is not assignable or transferable 
to any successor, without the express written permission of PerkinElmer, which may be withheld 
in its sole discretion.

ii. Customer agrees that as PerkinElmer's sole liability and as Customer's sole remedy, PerkinElmer 
will provide services to correct documented and reproducible errors which PerkinElmer's 
diagnosis indicates are caused by a defect in an unaltered version of the Software; provided that 
Customer advises PerkinElmer of such malfunctions of the Software within ten (10) days after 
expiration of the applicable Limited Warranty period.

C. THE FOREGOING LIMITED WARRANTY IS THE CUSTOMER'S SOLE AND EXCLUSIVE 
REMEDY AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED. 
PERKINELMER SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF 
ANTICIPATED BENEFITS OR PROFITS, LOSS OF SAVINGS OR REVENUE, PUNITIVE 
DAMAGES, LOSS OF USE OF THE SYSTEM OR ANY ASSOCIATED EQUIPMENT, COST OF 
CAPITAL, COST OF ANY SUBSTITUTE EQUIPMENT OR FACILITIES, DOWNTIME, THE 
CLAIMS OF ANY THIRD PARTIES, INCLUDING CUSTOMERS, AND INJURY TO 
PROPERTY, RESULTING FROM THE PURCHASE OR USE OF THE SYSTEM OR SOFTWARE, 
OR ARISING FROM BREACH OF THE WARRANTY, BREACH OF CONTRACT, 
NEGLIGENCE, STRICT TORT, OR ANY OTHER LEGAL OR EQUITABLE THEORY, EVEN IF 
PERKINELMER KNEW OF THE LIKELIHOOD OF SUCH DAMAGES. PERKINELMER SHALL 
NOT BE LIABLE FOR DELAY IN RENDERING SERVICE UNDER THE LIMITED 
WARRANTY, OR LOSS OF USE DURING THE PERIOD THAT THE SYSTEM OR SOFTWARE 
IS BEING REPAIRED. PERKINELMER DOES NOT REPRESENT OR WARRANT THAT THE 
EQUIPMENT OR SOFTWARE WILL BE FREE FROM DEFECTS, UNINTERRUPTED OR, 
ERROR-FREE.

D. Some countries, states or provinces do not allow the exclusion or limitation of implied warranties or 
the limitation of incidental or consequential damages for certain products or the limitation of liability 
for personal injury, so the above limitations and exclusions may be limited in their application to you. 
When any implied warranties are not allowed to be excluded in their entirety, they will be limited to 
the duration of the applicable written warranty. This Limited Warranty gives you specific legal rights 
which may vary depending on local law.

E. This Limited Warranty shall be governed by the laws of the Commonwealth of Massachusetts, 
U.S.A., excluding its conflicts of laws principles and excluding the United Nations Convention on 
Contracts for the International Sale of Goods.

9.3 Trademarks
The names of companies and products mentioned herein may be the trademarks of their respective 
owners. PerkinElmer is a registered trademark of PerkinElmer, Inc. Apple, Macintosh, and 
QuickTime are registered trademarks of Apple Computer, Inc. Microsoft, PowerPoint, and Windows 
are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or 
other countries. Intel and Pentium III is a registered trademark of Intel Corporation. Adobe and 
Illustrator are either registered trademarks or trademarks of Adobe Systems Incorporated in the 
United States and/or other countries.
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9.4 Disclaimers
A. Use of the Software. The Software and related documentation may be subject to clickwrap, shrink 

wrap, or other end user license agreements containing restrictions on use and disclosure and are 
protected by intellectual property laws. Except as expressly permitted in your license agreement or 
allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, 
distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse 
engineering, disassembly, or decompilation of this software, unless required by law for 
interoperability, is expressly prohibited.

B. Use of the System. This manual has been developed for use by properly trained individuals only and 
use by individuals who have not received proper training is not advised. Any changes or 
modifications of the System, not expressly approved by PerkinElmer, will void the Limited Warranty 
and any repair thereafter shall be charged to the Customer. Any movement of the System not 
performed by authorized personnel of PerkinElmer may void the Limited Warranty. Failure to 
operate the System in accordance with this manual is likely to cause safety hazards, personal injury, 
property damage, and/or other damages. 



Appendix A   Troubleshooting
Issue Possible Cause Corrective Action

Cannot turn on the CT 
scanner

Emergency Stop button has 
been pressed.

Release the Emergency Stop button.

Key switch is in the OFF 
position (left position).

Turn the key switch to the ON position (turn to 
the right).

The cover is open. Check to see if any of the device cover is missing 
and make sure that all screws are tightly fastened 
for all covers.



Appendix B   User-Replaceable Parts
Item Part No.

Bore Cover Large, GX CLS143641 

Bore Cover Small CLS134993

Bed Large CLS134994

Bed Small CLS134995

Transfer Bed (for use with Mouse Imaging Shuttle) 127167

Adapter (for use with FMT Mouse Imaging Cassette) CLS136435



Appendix C   System Shutdown
PerkinElmer does not recommend power cycling the Quantum GX2  micro CT (turning the system 
components on and off). If it is necessary to shut down the scanner for any reason, it is important to 
follow the procedure below.

1. Make sure that all processes are finished. Confirm that the gantry and sample bed are not moving.

2. Close the Control Panel and Database window. If prompted, save any data.

3. Turn off the computer using the standard Windows® shut down procedure.

This also shuts down the Quantum GX2  micro CT scanner.

4. Turn off the power to the other system components and power surge protection devices.

If you have any concerns during the shut down procedure, please contact PerkinElmer technical 
support (see page 4) for assistance.

NOTE: The Emergency Stop button is not intended as a main X-ray source control and should not
be used to turn the X-ray function ON or OFF on a routine basis. It should only be used in the
unlikely situation where the X-ray source must be immediately turned OFF.

http://www.perkinelmer.com/tools/technicallibrarylandingpage
http://www.perkinelmer.com/tools/technicallibrarylandingpage
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